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Overview

X-Author for Excel addresses two key areas for using Excel and Salesforce together.

For Salesforce applications like CRM, Apttus CPQ or other custom applications. X-Author 

lets you use Microsoft Excel natively as a user interface (UI) for tasks that really need Excel rather 

than a browser UI. You can use a new or existing spreadsheet to connect to Salesforce, or you 

can launch a spreadsheet directly from within Salesforce. X-Author for Excel can accommodate 

many formats (not just grids), simultaneously use multiple objects, and access data that is spread 

across multiple worksheets, and make use of powerful query capabilities.

For traditional stand-alone spreadsheets. In many companies, there are hundreds of thousands 

of spreadsheets. In these companies, people route spreadsheets through email and shared drives. 

This means you don’t always know who has the latest version. If worksheets are being cut and 

pasted into other spreadsheets, it takes a lot of time to get properly consolidated reporting, and 

integrity is often questionable. For these use cases, consider having some or all the data in these 

spreadsheets housed in Salesforce. With X-Author, you can retain the Microsoft Excel UI and 

formats, but the data is instantly available in the Salesforce cloud for easy enterprise control, 

reporting, and routing. Because X-Author centralizes the Microsoft Excel templates in Salesforce, 

you can create and enforce security and version control over the data even though it’s being used 

in Microsoft Excel.

In both cases, you can use just the Microsoft Excel UI and the data will move between Excel and 

Salesforce. Or, if you still need the actual Microsoft Excel file for audit purposes—or perhaps 

because it contains more data than what you might choose to store in Salesforce—X-Author offers 

file check-in and check-out capabilities to provide centralized control.
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https://documentation.apttus.com/label/XAEFEB17/action-flows
https://documentation.apttus.com/label/XAEFEB17/actions
https://documentation.apttus.com/label/XAEFEB17/application-settings
https://documentation.apttus.com/label/XAEFEB17/apps
https://documentation.apttus.com/label/XAEFEB17/cells-and-columns
https://documentation.apttus.com/label/XAEFEB17/configuration
https://documentation.apttus.com/label/XAEFEB17/creating-apps
https://documentation.apttus.com/label/XAEFEB17/designer-features
https://documentation.apttus.com/label/XAEFEB17/display-maps
https://documentation.apttus.com/label/XAEFEB17/examples
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https://documentation.apttus.com/label/XAEFEB17/field-lookups
https://documentation.apttus.com/label/XAEFEB17/file-attachments
https://documentation.apttus.com/label/XAEFEB17/filters
https://documentation.apttus.com/label/XAEFEB17/getting-started
https://documentation.apttus.com/label/XAEFEB17/installation
https://documentation.apttus.com/label/XAEFEB17/layouts
https://documentation.apttus.com/label/XAEFEB17/list-ranges
https://documentation.apttus.com/label/XAEFEB17/mapped-fields
https://documentation.apttus.com/label/XAEFEB17/matrix-maps
https://documentation.apttus.com/label/XAEFEB17/new-features
https://documentation.apttus.com/label/XAEFEB17/overview
https://documentation.apttus.com/label/XAEFEB17/permissions
https://documentation.apttus.com/label/XAEFEB17/preloaded-grids
https://documentation.apttus.com/label/XAEFEB17/proxy-authentication
https://documentation.apttus.com/label/XAEFEB17/records
https://documentation.apttus.com/label/XAEFEB17/ribbon-menus
https://documentation.apttus.com/label/XAEFEB17/rich-text-fields
https://documentation.apttus.com/label/XAEFEB17/runtime-functions
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Installing X-Author for Excel

The following table summarizes the components required to install and begin working with X-

Author for Excel. Refer to Release Notes for the most current versions.

Component Type Notes

Apttus X-Author for Excel 

(Apttus_XApps / Runtime).

Salesforce 

Managed 

Package

This package must be installed first.

Apttus X-Author Designer 

for Excel 

(Apttus_XAppsDS / 

Designer).

Salesforce 

Managed 

Package

Apttus X-Author for Excel: 

Designer + Runtime

Microsoft 

Excel Add-

in

This add-in allows you to work with the X-Author 

Excel and X-Author Designer tabs in Microsoft Excel 

(Designers and Admins).

Apttus X-Author for Excel: 

Runtime Only

Microsoft 

Excel Add-

in

This add-in allows you to work with the X-Author 

Excel tab in Microsoft Excel (Runtime users).

The following packages are optional and may be required in addition to the above 
components based on your license(s). 

Apttus X-Author for Excel 

(Admin)

Salesforce 

Managed 

Package

Required for Power Admin licenses or the legacy Data 

Migration product.
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Component Type Notes

Apttus Document 

Generation

Salesforce 

Managed 

Package

Required for X-Author Presto licenses. This package 
must be installed first.

Apttus X-Author for Excel 

Document Generation

Salesforce 

Managed 

Package

Required for X-Author Presto licenses.

Minimum Packages Required by Role

The following table describes the minimum Salesforce package licenses required for specific X-

Author roles.

Role Salesforce Package(s) Licensed

Runtime 

User

X-Author for Excel

Designer X-Author for Excel, X-Author Designer for Excel

Power 

Admin

X-Author for Excel, X-Author Designer for Excel, X-Author for Excel (Power 

Admin)

Presto User X-Author for Excel, Document Generation, X-Author for Excel Document 

Generation
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Setting Salesforce Permissions

After you install X-Author, you must provide users with the proper permissions for accessing the 

managed packages. Additionally, you must set field-level permissions on the App object that is 

created during the installation of the managed package.

Assigning User Profile Permissions

You must assign the following permissions in Salesforce to the user profiles of users who will use 

X-Author for Excel. Unless they have a System Administrator profile, users will not automatically 

have access to the package contents that are required to access X-Author functionality. The 

following permissions must be configured.

Runtime Users

Custom App Settings Apttus X-Author for Excel: Visible

Tab Settings X-Author for Excel: Default on

Custom object permissions Apps: Read

App Assignments: Read

App Files: Read / Create / Edit / Delete

Enabled Apex Class Access Apttus_XApps.AppBuilderWS

Enabled Visualforce Page Access Apttus_XApps.SearchSelectAction

Apttus_XApps.Landing

Designer Users

Custom App Settings Apttus X-Author for Excel: Visible
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Designer Users

Tab Settings X-Author for Excel: Default on

X-Author Designer: Default on

Apps: Default on

App Licenses: Default on

Custom object permissions Apps: Read / Write

App Assignments: Read / Write

App Files: Read / Create / Edit / Delete

Enabled Apex Class Access Apttus_XApps.AppBuilderWS

Enabled Visualforce Page Access Apttus_XApps.SearchSelectAction

Apttus_XApps.Landing

Apttus_XApps.LicenseManager

Apttus_XAppsDS.DesignerInfo

Apttus_XAppsDS.AppAssignmentOverview

Apttus_XAppsDS.AppAssignmentUsers

Apttus_XAppsDS.AppAssignmentProfiles

Default Permission Sets

From the May release onwards, the X-Author for Excel Designer and Runtime packages comprise 

the default permission sets for designer and runtime users with requisite permissions needed to 

design and run apps respectively.
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1.  

2.  

3.  

4.  

5.  

6.  

7.  

Assigning Field-Level Permissions

The Activated and UniqueId fields on the App object must be set to visible. Usually, these 

permissions will be set during the installation of the managed package. However, depending on 

org-specific security settings, you might need to set these permissions manually.

To set the field-level permissions

In Salesforce App Setup, go to Create > Objects > App.

Click Custom Fields and Relationships.

Click Activated.

Click Set Field Level Security.

Make sure that the Visible check box is selected for every profile that requires app access.

Repeat steps 3 through 5 for the UniqueId custom field definition.

Click Save.

Apttus X-Author for Excel Objects

The following objects contain fields that are maintained in the corresponding tables for the objects.

X-Author for Excel 
Object

Purpose of the Object

App Apttus X-Author Excel Application

App Assignment Assignment of X-Author for Excel App to user or profile

App File Apttus X-Author for Excel™ Application Files for Check-in and Check-

Out functionality
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X-Author Add-ins

There are two executable files:

X-Author Designer, which comes bundled with X-Author for Excel

X-Author for Excel, which is to be installed for end users who will not be designers

The installation process creates a folder on your computer that contains the files required to use 

the X-Author Designer and the X-Author for Excel add-ins. Depending on the version of Windows 

you are using, the folder is created either in your Program Files or Program Files (x86) directory.

Installation Requirements

Your computer must meet the minimum requirements listed below.

The Mac OS X operating system is not supported; however X-Author can be used on a 

Mac that is running a Windows Virtual Machine in a VMWare or Parallels environment.

Component Requirement

Microsoft Microsoft Excel 2010 (32 bit & 64 bit), Microsoft Excel 2013 (32 bit & 64 bit)

Microsoft Microsoft .NET Framework 4.5

Microsoft Microsoft Visual Studio 2010 Tools for Office Runtime

Microsoft Microsoft Office 2010 Primary Interop Assemblies

Salesforce Any Salesforce edition that provides API support for the Salesforce objects that 

will be accessed in an X-Author for Excel App.

Before you install X-Author Designer:

You must be connected to the Internet.
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1.  

2.  

3.  

4.  

5.  

6.  

You must have access to the X-Author for Excel or X-Author Designer executable file.

You must have Administrator permissions on the computer being used for the install.

You must close all instances of Microsoft Excel.

To Install X-Author Designer or X-Author for Excel

Double-click the installer executable to display the InstallShield Wizard. In rare instances, a 

restart of Windows may be required. Click Yes to confirm the restart and, once you log in to 

Windows, the installer should resume automatically.

Click Next to start the wizard.

On the License Agreement screen, select I accept. and click Next. If you do not accept the 

terms of the agreement, X-Author will not be installed on your computer.

Click Install to begin the installation process. If any components need to be installed for X-

Author to work as expected, they will be automatically detected as missing and installed. If 

components are required but cannot be accessed through the Internet, an appropriate 

message will be displayed and the install will need to be completed after all missing 

components have been manually installed.

Click Finish to close the wizard and complete the installation.

Open Microsoft Excel.

The X-Author Designer and/or X-Author for Excel ribbon tab should be available in Excel. If the 

ribbon tab is not displayed, you may need to register X-Author Designer or X-Author for Excel with 

Excel.

Correcting Missing X-Author Add-in tabs

From the May Patch 1 release onwards, the X-Author for Excel, Designer, and Runtime Tabs in 

Excel need not be enabled from COM Add-ins in Excel manually every time an instance of 

Microsoft Excel is opened. A registry diagnostic tool that Apttus provides fixes the Registry load 

setting behavior of Microsoft Excel. When a user installs our regular build, the diagnostic utility will 

be a part of it in the install directory. A shortcut for the Diagnostic Utility is also created on the 

desktop.
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1.  

2.  

3.  

You need to have administrator rights in the system you want to run the diagnostic tool in. Run the 

appbuilder_diagnosis executable and Press Enter.

In rare cases, the X-Author Designer or X-Author for Excel tabs are not properly installed and, 

therefore, are not visible in your Microsoft Excel ribbon menu. If this occurs, you must manually 

register the X-Author add-in to add it to the Excel ribbon.

To manually register the Add-Ins

Start Excel and select File > Options to display the Excel Options dialog.

Click Add-Ins, select COM Add-ins from the Manage list, and click Go.

Click the Apttus X-Author Designer and X-Author for Excel check boxes and click OK.
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1.  

The add-ins will now be available in the Excel ribbon; however, you may need to restart Excel for it 

to display as expected.

Enabling Proxy Authentication

By default, X-Author for Excel will use your Microsoft Internet Explorer (IE) proxy settings. Because 

the IE settings are used to connect to your Salesforce org, the default configuration will work for X-

Author in most cases. However, if your work environment is behind a firewall and you need to 

manually configure proxy authentication to connect to Salesforce, you must complete the 

procedure in this section.

Microsoft Internet Explorer Proxy Settings

Proxy server settings in IE are located at Tools > Internet Options > Connections > LAN 

Settings. However, the location of the proxy server settings in IE may be different due to 

your IE version. Refer to Microsoft IE's documentation for more information.

To enable X-Author for proxy authentic ation

Open Excel and click either the X-Author Designer or X-Author for Excel tab.
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1.  

2.  

3.  

In the lower right corner of the Access section, click  . The X-Author Designer dialog 

opens.

On the General tab, click one of the following radio buttons.
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3.  

4.  

Setting Description

No proxy Click this radio button if you do not use a proxy connection.

Use system 

proxy

Click this radio button to use the Microsoft Internet Options setting to 

determine your proxy server settings. If you choose this option, X-Author 

will automatically resolve the connection so that you can successfully login 

to X-Author and connect to your Salesforce org. This is the default setting.

Manual 

proxy 

configuration

Click this radio button to enter the settings for the proxy server you will be 

using. If you choose this option, you must enter the address and port 

number of your proxy server in the Proxy Address to Use and Port fields, 

respectively. If you are required to provide authentication information, click 

the Authenticated check box and enter a user name and password in the 

provided fields.

Click Apply and Close.

Your system proxy settings are now associated with X-Author Designer and will take effect the 

next time you log in.

Multi-Language Support

X-Author for Excel is available in the Japanese (Nihongo) language. Currently, the application 

supports Validation Messages, Captions, Labels, Error Messages, and Warnings in the Japanese 

(Nihongo) language. The actual data remains as in the Salesforce org.

From the May Patch 2 release onwards, you can now choose a language to display the data in X-

Author for Excel. Currently the supported languages are English and Japanese.

Go to Support > General Settings and set the language preference as English or Japanese. After 

changing this option, restart Microsoft Excel.
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1.  

2.  

3.  

Completing Setup for Designers

Designers must have two buttons added to their layouts before they can use X-Author Designer: 

the Assign button and the Excel Setup button.

To add the Assign button

Go to Setup > App Setup > Create > Objects.

Click the App object.

Hover over the Page Layouts button (located at the top of the page) and click Edit next to 

Application Layout.
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3.  

4.  

5.  

In the left panel, click Buttons.

If the Assign button isn't in the displayed as shown in the following figure, you will need to 

add it for designers.

Add the assign button to the layout which leads you to the user profile page.

To add the Edit in Excel Setup button

Designers must have the Edit in Excel Setup button added to their layout on the Apps List view in 

order to use the Launch from Salesforce feature.
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1.  

2.  

3.  

Go to Salesforce Setup > Create > Objects and click App.

In the Search Layouts section, click Edit next to Apps List View and move the Edit in Excel 

Setup to Selected Buttons.

Click Save.
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Getting Started with X-Author for Excel

This section contains information to help you get started with X-Author for Excel.

Required Licenses

Apps and Where They’re Stored

About App Creation and Execution

App Migration and Cloning

Testing Apps

Switching Between Design and Runtime instances

Required Licenses

App creation requires a combination of licenses and user assignment:

Apttus Licenses

One or more X-Author for Excel product editions e.g. X-Author Enterprise or X-Author 

Power Admin

User Assignment:

X-Author Designer Package—Assignment to this package is required for app designers.

X-Author for Excel Package —Assignment to this package is required for designer and 

runtime users who can run any app that has been both activated and assigned to them by a 

designer.

X-Author for Chatter Package —Assignment to this package is required to use the 

embedded X-Author for Chatter functionality.

Salesforce Licenses

To access Salesforce.com from Microsoft Excel using any X-Author for Excel edition, a user 

must have an API-enabled Salesforce.com license to the objects they need to access.

To use X-Author for Chatter, Salesforce Chatter licenses with API access are required.
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Apps and Where They’re Stored

An X-Author for Excel application (app) is created within Microsoft Excel using X-Author Designer. 

There is no coding because all configuration is accomplished through the point-and-click designer. 

An app is the combination of: 

A Microsoft Excel template that contains the Excel workbook layout.

An XML file that contains the app-specific User Menus, Action Flows, maps, and other user-

experience elements.

Apps are stored in the Applications object within a Salesforce org. Each App is represented by one 

application record in which the Microsoft Excel spreadsheet template, an XML file, and other 

configuration data are stored in the Notes and Attachments. (These files should not be edited 

without using the X-Author Designer or it may corrupt the App.)

X-Author for Excel apps are not related to the Salesforce definition of an application or app. A 

single X-Author App can include any number of objects that span any number of Salesforce 

applications.

About App Creation and Execution

Apps can take as little as 5 minutes to create using the individual X-Author Designer components 

or less than a minute with the Quick App function. Using the full Designer, Apps are built by 

working from left to right on the X-Author Designer ribbon, starting with the Apps button and ending 

with the Application Settings button.

During runtime, the order is reversed. The end user clicks a ribbon button that calls an action flow, 

which executes a sequential set of actions that retrieve, save, or manipulate the data.

App Migration and Cloning

Using X-Author for Excel's import and export capabilities, you can quickly transfer apps from one 

Salesforce org to another.
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The objects and fields in the source Salesforce org (the org you are exporting from) must 

also exist in the target Salesforce org.

You can also clone apps using the Clone function located in the Save Application menu in the X-

Author Designer ribbon.

Testing Apps

App design is performed in the X-Author Designer tab, but app testing is performed in the X-Author 

for Excel tab. The Preview button switches the app from design into runtime mode.

Make sure you have saved your app before clicking Preview.

Switching Between Design and Runtime instances

If you have both Design and Runtime instances open at the same time, switch between them using 

the task bar and not the Add-in tabs.

Connecting to Salesforce from Excel

Now that you have installed X-Author, you need to open Excel and connect X-Author to your 

Salesforce org. You can create connections to multiple Salesforce orgs, switch between orgs 

without leaving Excel, and revoke existing connections.

Connecting to Salesforce from Excel

Adding More Connections

Switching Salesforce Connections

Revoking Connections
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1.  

2.  

3.  

4.  

5.  

6.  

Connecting to Salesforce from Excel

Use the following process to connect to your Salesforce org.

To connect to Salesforce from X-Author Designer

Open Excel.

In the X-Author Designer or X-Author for Excel ribbon menu, click Connect.

If this is the first time you have connected to Salesforce, the Manage Connections window 

opens.

Under the Create a new connection section and in the Name field, enter the Salesforce.com 

user name.

If you have previously connected to Salesforce, but need to connect to a different 

org, refer to S .witching Salesforce Connections

In the Login URL field, type the URL you use to log in to Salesforce (In many cases, the URL 

is  for production orgs and  for sandboxes. You can login.salesforce.com test.salesforce.com

click the shortcut for either of these in the Examples section).

Click Authorize. The Salesforce login window opens.

http://login.salesforce.com
http://test.salesforce.com
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6.  

1.  

2.  

3.  

4.  

5.  

6.  

Type your username and password in the provided fields and click Log in to Salesforce.

The X-Author Designer ribbon is fully enabled. Now you can start designing an app or using 

existing apps.

Adding More Connections

If you use X-Author for Excel with more than one Salesforce org, you can connect to multiple 

instances of Salesforce.

To add a Salesforce connection

Open Excel.

In the X-Author Designer or X-Author for Excel ribbon menu, click Switch Connection and 

select Manage Connections. The Manage Connections window opens.

Under the Create a New Connection section, enter the Salesforce.com user name.

In the Login URL field, type the URL you use to log in to Salesforce (In many cases, the URL 

is login.salesforce.com for production orgs and test.salesforce.com for sandboxes. You can 

click the shortcut for either of these in the Examples section).

Click Authorize. The Salesforce login window opens.

Type your username and password in the provided fields and click Log in to Salesforce.
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1.  

2.  

3.  

1.  

2.  

The X-Author Designer ribbon is fully enabled. Now you can start designing an app or using 

existing apps.

Switching Salesforce Connections

If you have previously connected to a Salesforce org and now need to connect to a different org, 

you will need to switch connections because the connection will default to the org you most 

recently connected to. Use the following procedure to switch from one org to another, regardless of 

whether or not you are already connected to an org.

To switch Salesforce connections

In the X-Author Designer or X-Author for Excel ribbon menu, click Switch Connection.

Select a connection from the drop-down menu. The Salesforce login window opens.

Type your password and click Log in to Salesforce.

The X-Author Designer ribbon is fully enabled. Now you can start designing an app or using 

existing apps.

Revoking Connections

If you no longer need to connect to a Salesforce org, you can revoke the connection. After a 

connection is revoked, you will no longer see that connection as an option when switching or 

managing connections.

To revoke a Salesforce connection

Open Excel.
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2.  

3.  

4.  

1.  

2.  

3.  

4.  

5.  

In the X-Author Designer ribbon menu, click Switch Connection and select Manage 

Connections. The Manage Connections window opens.

Click the Revoke button next to the connection you want to remove. The Revoke Access 

confirmation window opens.

Click Yes to confirm the revocation.

The connection will no longer be available in X-Author.

Follow the installation instructions to get the packages and add-ins installed and to connect to your 

Salesforce org.

Activating and Assigning Apps

Once you have created and app, you need to activate the app in Salesforce and assign it to 

runtime users.

Activating Apps

After you create an app in X-Author for Excel, the app must be activated in Salesforce.

To activate apps

Login to Salesforce.

In the  app menu, click X-Author for Excel.Force.com

Click Apps.

Click Edit next to the newly created app.

Click the Activate check box and click Save.

The app has been activated. Now you can assign it to users.

Assigning Apps to Runtime Users

Now that you have activated the app, you need to assign it to runtime users. Assigning the app 

allows specific users or users with specific profiles to access the app in the X-Author for Excel 

ribbon menu in Excel.

http://Force.com
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1.  

2.  

3.  

4.  

5.  

6.  

1.  

2.  

To assign apps to runtime users

Login to Salesforce.

In the  app menu, click X-Author for Excel.Force.com

Click Apps.

Click Assign next to the newly created app.

Check the boxes for the appropriate users or profiles.

Click Save.

Previewing Apps

Now that you have created an app, you can preview the app, running it as a user would.

To preview an app

After creating an app, click the Preview button in the ribbon menu.

The app opens in the X-Author for Excel tab.

When you click Preview, a new worksheet opens and X-Author for Excel must 

reconnect to the Salesforce org. This may take a few seconds.

In the ribbon menu, click the Retrieve button to download data from Salesforce into Excel.

http://Force.com
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You can now test your app by retrieving data and adding, pasting, and deleting rows.

Example of Previewing an App

In this example, we will preview a parent-child app (Accounts and Opportunities, respectively) that 

allows us to search by Account Name or Billing City. This is what our app looks like when it first 

opens.

In this example, Display fields are indicated by the blue background and Save fields are indicated by the 

green background. These colors can be set when creating apps.

When you click the Retrieve button, the Search Account window opens. (Account is the parent 

object in our app.)
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Notice that you can search by Account Name, Billing City. These are the fields that were set as 

Search fields for the Accounts object when the app was designed.

Notice that the Account Name, Billing City, Billing Country, and Last Activity fields are all displaying 

in the results panel. These are the fields that were set as Results fields when the app was 

designed.

If you want to see all Opportunities for only the Toronto office of Global Media, you can type search 

text in both search fields.

To search all available search fields at one time, you would type your search text in the Search 

Across Filters text box.

For this example, we will search for all opportunities in Toronto, Canada.
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Double-click the search result you want to retrieve data from, or select a row and click Next. The 

Search Opportunities window opens. (Opportunities is the child object in our app.)

Again, all of the search fields available on this page are the fields that were configured to be 

search fields for the Opportunities object when the app was created. You can use these search 

fields to narrow your results.

In our case, we want to retrieve all three of the opportunities that were retrieved, so we will click 

the Select All check box and click Next.

The search window closes and our data is retrieved and added to our Excel worksheet.
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Designing Apps

All of the controls you need to use X-Author Designer are located in the X-Author Designer ribbon 

menu in Microsoft Excel.

Before you start designing apps, you should familiarize yourself with the X-Author for Excel 

components that are accessed through the X-Author Designer ribbon menu. Click the link in the 

first column to learn more about the component.

Component Description

Apps Click this button to create a new app, change the app type, or open an existing 

app. (Click the Quick App button to instead create a simple single-object app or a 

parent-child-type app.)

Salesforce 

Objects

Click this button to specify the Salesforce objects and fields you will use in the 

app. (This section only covers single object and parent-child objects.)

Display Map Click this button to define the associations between Excel spreadsheet cells and 

Salesforce fields for the Salesforce data to be retrieved. When data is retrieved 

from Salesforce, using one of the X-Author data invoking actions, it is temporarily 

stored in Excel memory before being placed into the worksheet. X-Author then 

uses a Display Map to place the data in the correct Excel cells.

Save Map Click this button to define relationships between Salesforce fields and Excel cells 

for data that will be saved to Salesforce.

Actions
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Component Description

Click this button to assign actions to your app. Actions can be used to retrieve, 

display, and save data. They can also automate tasks in Excel worksheets and 

call Salesforce methods.

Action Flow Click this button to define a sequence of one more actions that will be executed 

when end users click buttons on the app's ribbon menu.

User Menus Click this button to create the ribbon menus that your end users will see in the X-

Author for Excel ribbon in Excel.

Matrix Map Click this button to define a matrix map. Matrix maps extend the capabilities of X-

Author for Excel well beyond list formats. In lists, one Salesforce record is 

represented per Excel row or column. Using matrices, a record can be 

represented by one or more cells by mapping columns and rows (the X and Y 

axes) of a matrix as well as the data contained in the cell at the intersection of the 

mapped column and row. Depending on the type of matrix, various data cells can 

be updated by a user. If no value exists in a cell, adding a value can create a new 

record depending on the matrix design.

Save App Click this button to save or clone your application.

App Settings Click this button to restrict runtime functions (such as saving, printing, rich-text 

editing) and password-protect worksheets.

Importing 

and 

Exporting 

an 

Application

Click these buttons to migrate X-Author for Excel apps from one Salesforce org to 

another.

Note: All Salesforce objects used in the source org must also exist in the 

destination org.

Migrating 

Applications

Click this button to easily migrate data from one Salesforce org to another using X-

Author for Excel.
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Component Description

Connect Click this button to connect to your Salesforce org, to switch to another org, or to 

revoke a previously configured connection.

External 

Library

As an application designer, you can choose to create additional custom actions 

apart from the ones provided in the X-Author for Excel executable packages. For 

example, you can create a custom action to populate missing External IDs for the 

Custom Objects in your org.

About Designing Apps

Apps can be created in two ways — using the full featured designer components or with a Quick 

App. When you use the Designer, each of the components must be configured manually (for 

example, Display Map and Save Map).

Note

A third type of app can be created using the Data Migration Wizard. This app is 

specifically designed for migrating data between two organizations. For information on 

creating a Data Migration app, refer to .Using the Data Migration Wizard

A Quick App is a 1 – 2 minute wizard experience where a designer can create a simple single 

object list on its own (for example, Opportunities) or a list filtered by a parent object (for example, 

Opportunities by Account).

The Quick App produces a complete, ready to run app that includes:

Two (max) objects

One Display Map, one Save Map, two Action Flows (Data Retrieve and Save), and two User 

menus (Retrieve and Save). No additional components are available. The Quick App 

functionality equates to the X-Author Essentials license. A Quick App can be edited using 

the Quick App editing function but if a Quick App is opened and customized using the full 

Designer, it can no longer be an X-Author Essentials app.
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1.  

2.  

3.  

4.  

5.  

To learn how to create a Quick App, refer to .Creating Apps with Quick Apps

To create an Enterprise, Presto, Reporting, or Power Admin app

In the ribbon menu, click the Apps button and select New App.

Type the app name in the App Name field. This name will display as the window title in the 

Excel worksheet at runtime.

Give your app a name that is concise but also summarizes the basic purpose of the 

app.

To use a new Excel template, click the New radio button. Although most existing templates 

can be used, it is sometimes easier to start with a clean workbook unless users are very 

familiar with the existing file and change management is a concern.

To create an app from an existing Excel file, click the Existing radio button and then click 

Browse to select the template file.

Click Next.
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5.  

6.  

7.  

8.  

1.  

From the Select App Type pop-up, select the app edition.

Click Create.

In the ribbon menu, click Save App.

You have created an app shell and you are ready to add the various Designer components.

Creating Apps with Quick Apps

Prerequisite

Before you can create an app, you must connect to a Salesforce org that is configured for 

X-Author for Excel. For information on configuring and connecting to Salesforce, refer to 

 and .Setting Salesforce Permissions Connecting to Salesforce from Excel

Click the links below to see how to create single-object and parent-child Quick Apps, and to learn 

how to change your app's color scheme.

To create a Single Object App

To create a Single Object App

Click Quick App and select New.
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1.  

2.  

3.  

4.  

The Build a Quick App window opens.

Type the application name into the App Name field.

Give your app a name that is concise but also summarizes the basic purpose of the 

app.

Click the Single Object List radio button and then click Next. The Build a Quick App page 

opens.
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4.  

5.  

6.  

7.  

Click the Object drop-down menu and select a Salesforce object. The Select Fields section 

will display the fields associated with the object.

Click the check box next to the fields you want to include in your app. ( Notice that the 

)object's two primary fields are selected by default. 

You can search for Salesforce fields using the Search Fields search box. Click 

Clear to clear search terms and view the full list.

Click Next.

The Select Field Options window opens, displaying the fields that you selected in the 

previous step.

Select from the options in the following table.

Column Description
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7.  

Column Description

Data 

Criteria
Select the method you would like to use to retrieve data. —Select this Query
method to have the query automatically run, based on your app's 

predetermined search filters, and retrieve the data without user intervention. 

—Select this method to allow users to apply search filter criteria User Selection
before retrieving data.

Select All

Display 

Fields

Click this check box to include all object fields in the Display Map.

Save 

Fields

Click this check box to include all object fields in the Save Map.

Note: This check box is inactive unless Display Fields is checked.

Grid Columns

Display Click this check box to include this field's data in the data retrieved from 

Salesforce and displayed in the Excel workbook.

Order This represents the order, left to right, that fields will be displayed in. Click in the 

cell to edit the order.

Save Click this check box to allow users to change the data in these cells in the Excel 

workbook and then save those changes to Salesforce.

 Fields that are not Display fields cannot be Save fields.Note:

Search 

Fields

Click this check box to add a runtime search filter for this field. These filters will 

be used to limit the type of records returned when the runtime user retrieves 

data. For example, might make Billing Country a Search field so that you can 

retrieve data from only those accounts who have a billing address in Canada. 

This field appears only when the Data Criteria is set to User Selection.
 You must select at least one field, and ID fields are  searchable.Note: not
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7.  

Column Description

Result 

Fields

Click this check box to display this field in the search results when retrieving 

and filtering data from Salesforce. This field appears only when the Data 
Criteria is set to User Selection.

You must select at least one field and ID fields  be used.Note: cannot

As shown in the following images, the displayed columns will vary based on the Data Criteria 

you select.

Selecting Field Options with  Data CriteriaQuery

Selecting Field Options with Data CriteriaUser Selection 
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7.  

8.  To add a filter to the data, click Filters.

Complete the fields described in the following table to build your filter.

Field Description

Salesforce 

Object 

and Field

Click  to select the object and field that you want the filter to apply to.

 You cannot type the field name in the text field.Note:

Value 

Type
Select the value type from the drop-down menu. The value types change 
based on the Salesforce field or object selected.
• —Select this value to allow users to type in a value to search for. For Input
example, if the field is Account ID, you might choose to let them type or paste 

the account ID in the filter at runtime.

• —Select this value to prevent users from changing the Value field at Static
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8.  

Field Description

runtime.

• —Select this value to specify a system variable, such as System Variable
CurrentUser or CurrentDate, as the filter value.

• — User Input Select this value to allow users to change the Value field at 

runtime.

Operator Select a relational operator from the drop-down menu.

• —The field value is equal to the specified value.Equals
• —The field value is  equal to the specified value.Not equal to not
• —The field value begins with the specified value.Starts with
• —The field value contains the specified value string.Contains
• —The field does not contain the specified value string.Not contains
• —The field value is in the specified list of hard-return-separated values.In
• —The field value is in the specified list of hard-return-separated Not In
values.

Value Type the comparison value in this field or select the value from the drop-down 

menu. Your options will vary depending on the type of field you are 
filtering on.

Click this button to delete a filter row.

Add Row Click this button to add a new filter row.

Clear All Click this button to remove all filter rows.

Add Filter 

Logic

Click this button to display the Filter Logic field and define the Boolean logic 

used to relate filters. For example, you might want display results only when 

 of your filter conditions are met or you might want to display results when all
 filter conditions are met. You can use filter logic to do this. any Filter logic in 

 X-Author for Excel works the same as it does in . Salesforce.com Learn more

.

http://salesforce.com/
https://help.salesforce.com/htviewhelpdoc?id=working_with_advanced_filter_conditions_in_reports_and_list_views.htm&siteLang=en_US
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9.  

10.  

11.  

Click Save.

Click Next.

On Provide App Settings page, provide requisite information as described in the table.

Field Description

Enable App 

Launch from 

Salesforce

Select this check box to allow users to open this X-Author app from within 

the Salesforce application (as well as from within Excel).

Enable Save 

for Google 

Sheets

Select this check box to allow users to open this X-Author app from within 

the Google Sheets application (as well as from within Excel).

Worksheet 

Title

Type the title of the Excel worksheet. The title appears in the top row of the 

worksheet.

Max Column 

Width

Type the maximum width of an Excel column (in characters).

View 

Gridlines

Select this check box to display the gridlines in the Excel worksheet.

Display 

Filters

Clear this check box if you do not want the filters that you created to 

appear in the Excel worksheet.

Group Label Type the ribbon menu group name. This value appears beneath the 

buttons in the X-Author for Excel ribbon tab.

Retrieve 

Data Button 

Label

Type the text you want to appear on the ribbon menu button used for data 

retrieval.
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11.  

12.  

1.  

2.  

3.  

Field Description

Save Data 

Button Label

Type the text you want to appear on the ribbon menu button used for 

saving data to the Salesforce database.

Enable Add 

Row

Select this check box to allow users to add rows to the Excel worksheet. 

This option could be used to add records to the workbook so those records 

can be uploaded to Salesforce.

Enable 

Delete Row

Select this check box to allow users to delete rows from the Excel 

worksheet.

Click Finish.

An App has been created with all design functions complete. You can now , run Preview the app

the app, or use X-Author Designer to make additional modifications.

To create a Parent Child app

To create a Parent Child app

Click Quick App and select New.

The Build a Quick App window opens.

Type the application name into the App Name field.

Give your app a name that is concise but also summarizes the basic purpose of the 

app.

https://documentation.apttus.com/display/XAESEAUG15/Previewing+Apps
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3.  

4.  

5.  

6.  

Click the Parent Child radio button and then click Next. The Build a Quick App page opens.

Click the Object drop-down menu and select a Salesforce object. The Select Fields section 

will display the fields associated with the object.

Click the check box next to the fields you want to include in your app. ( Notice that the 

)object's two primary fields are selected by default. 

You can search for Salesforce fields using the Search Fields search box. Click 

Clear to clear search terms and view the full list.
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6.  

7.  

Click Next  The Select Field Options window opens, displaying the fields that you selected in .
the previous step.

Select the Child Object and the fields that you want to include in your app.
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7.  

As shown in the following images, the displayed columns will vary based on the Data Criteria 

you select.

Selecting Field Options with Data CriteriaQuery 
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7.  

 

Selecting Field Options with Data CriteriaUser Selection 
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7.  

8.  Select from the options in the following table.

Column Description

Data 

Criteria
Select the method you would like to use to retrieve data. —Select this Query
method to have the query automatically run, based on your app's 

predetermined search filters, and retrieve the data without user intervention. 

—Select this method to allow users to apply search filter criteria User Selection
before retrieving data.

Select All

Click this check box to include all object fields in the Display Map.



X-Author for Excel February 2017 Designer and Runtime Guide

56 Copyright ©2011-2017 Apttus Corporation. All rights reserved.

8.  

9.  

Column Description

Display 

Fields

Save 

Fields

Click this check box to include all object fields in the Save Map.

: This check box is inactive unless Display Fields is checked.Note

Grid Columns

Display Click this check box to include this field's data in the data retrieved from 

Salesforce and displayed in the Excel workbook.

Order This represents the order, left to right, that fields will be displayed. Click in the 

cell to edit the order.

Save Click this check box to allow users to change the data in these cells in the Excel 

workbook and then save those changes to Salesforce.

 Fields that are not Display fields cannot be Save fields.Note:

Search 

Fields

Click this check box to add a runtime search filter for this field. These filters will 

be used to limit the type of records returned when the runtime user retrieves 

data. For example, might make Billing Country a Search field so that you can 

retrieve data from only those accounts who have a billing address in Canada. 

This field appears only when the Data Criteria is set to User Selection.
 You must select at least one field, and ID fields are  searchable.Note: not

Result 

Fields

Click this check box to display this field in the search results when retrieving 

and filtering data from Salesforce. This field appears only when the Data 
Criteria is set to User Selection.

You must select at least one field and ID fields  be used.Note: cannot

To add a filter to the data, click Filters.

Complete the fields described in the following table to build your filter.
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9.  

Field Description

Salesforce 

Object 

and Field

Click  to select the object and field that you want the filter to apply to.

 You cannot type the field name in the text field.Note:

Value 

Type
Select the value type from the drop-down menu. The value types change 
based on the Salesforce field or object selected.
• —Select this value to allow users to type in a value to search for. For Input
example, if the field is Account ID, you might choose to let them type or paste 

the account ID in the filter at runtime.

• —Select this value to prevent users from changing the Value field at Static
runtime.

• —Select this value to specify a system variable, such as System Variable
CurrentUser or CurrentDate, as the filter value.

• — User Input Select this value to allow users to change the Value field at 

runtime.

Operator Select a relational operator from the drop-down menu.

• —The field value is equal to the specified value.Equals
• —The field value is  equal to the specified value.Not equal to not
• —The field value begins with the specified value.Starts with
• —The field value contains the specified value string.Contains
• —The field does not contain the specified value string.Not contains
• —The field value is in the specified list of hard-return-separated values.In
• —The field value is in the specified list of hard-return-separated Not In
values.

Value Type the comparison value in this field or select the value from the drop-down 

menu. Your options will vary depending on the type of field you are 
filtering on.
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9.  

10.  

11.  

12.  

Field Description

Click this button to delete a filter row.

Add Row Click this button to add a new filter row.

Clear All Click this button to remove all filter rows.

Add Filter 

Logic

Click this button to display the Filter Logic field and define the Boolean logic 

used to relate filters. For example, you might want display results only when 

 of your filter conditions are met or you might want to display results when all
 filter conditions are met. You can use filter logic to do this. any Filter logic in 

 X-Author for Excel works the same as it does in . Salesforce.com Learn more

.

Click Save.

Click Next.

On Provide App Settings page, provide requisite information as described in the table.

Field Description

Enable App 

Launch from 

Salesforce

Click this check box to allow users to open this X-Author app from within 

the Salesforce application (as well as from within Excel).

Enable Save 

for Google 

Sheets

Select this check box to allow users to open this X-Author app from within 

the Google Sheets application (as well as from within Excel).

Worksheet 

Title

Type the title of the Excel worksheet. The title appears in the top row of the 

worksheet.

http://salesforce.com/
https://help.salesforce.com/htviewhelpdoc?id=working_with_advanced_filter_conditions_in_reports_and_list_views.htm&siteLang=en_US
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12.  

13.  

Field Description

Max Column 

Width

Type the maximum width of an Excel column (in characters).

View 

Gridlines

Select this check box to display the gridlines in the Excel worksheet.

Display 

Filters

Clear this check box if you do not want the filters that you created to 

appear in the Excel worksheet.

Group Label Type the ribbon menu group name. This value appears beneath the 

buttons in the X-Author for Excel ribbon tab.

Retrieve 

Data Button 

Label

Type the text you want to appear on the ribbon menu button used for data 

retrieval.

Save Data 

Button Label

Type the text you want to appear on the ribbon menu button used for 

saving data to the Salesforce database.

Enable Add 

Row

Select this check box to allow users to add rows to the Excel worksheet. 

This option could be used to add records to the workbook so those records 

can be uploaded to Salesforce.

Enable 

Delete Row

Select this check box to allow users to delete rows from the Excel 

worksheet.

Click Finish.

An App has been created with all design functions complete. You can now , run Preview the app

the app, or use X-Author Designer to make additional modifications.

To customize the color scheme

To customize the color scheme

https://documentation.apttus.com/display/XAESEAUG15/Previewing+Apps
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1.  

2.  

To customize the color scheme

In the ribbon menu, click Quick App and select Settings.

The Format Options window opens.

Provide requisite information in the Format Options window as described in the table.

Field Description

Worksheet Title

Fill 

Color

Click this field to open the color picker and specify the background color for the 

worksheet title.

Text 

Color

Click this field to open the color picker and specify the text color for the 

worksheet title.

Font Click this field to open the Font window and specify font properties for the 

worksheet title.

Header Display Fields

Fill 

Color

Click this field to open the color picker and specify the background color for the 

Display fields.

Text 

Color

Click this field to open the color picker and specify the text color for the the 

Display fields.
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2.  

Field Description

Font Click this field to open the Font window and specify font properties for the the 

Display fields.

Header Save Fields

Fill 

Color

Click this field to open the color picker and specify the background color for the 

Save fields.

Text 

Color

Click this field to open the color picker and specify the text color for the Save 

fields.

Font Click this field to open the Font window and specify font properties for the Save 

fields.
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2.  

1.  

2.  

3.  

4.  

Example: Quick App for Opportunities by Account

You will use the Quick App wizard to create your first app, and it will take you only a few minutes.

You will build your app in only four steps.

Specify which type of app you need.

Select your objects and fields.

Select your display and save options and specify a method for getting the data from 

Salesforce.

Format your workbook.

Let's get started. Using these four steps, you are going to create an app that will:

Retrieve data from the Account and Opportunity objects in Salesforce.

Place that data in a Microsoft Excel worksheet.
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1.  

2.  

Allow you to edit the data in Excel and then save your changes in Salesforce.

Prerequisite

Before you can create an app, you must connect to a Salesforce org that is configured for 

X-Author for Excel. For information on configuring and connecting to Salesforce, refer to 

 and .Setting Salesforce Permissions Connecting to Salesforce from Excel

Click Quick App and select New.

The Build a Quick App window opens.

In the App Name field, type the application name. The name appears as the Excel window 

title (located at the top of the Excel window) in the completed app.
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2.  

3.  

Give your app a name that is concise but also summarizes the basic purpose of the 

app.

For this example, you are going to create an Opportunity forecasting app. The app allows 

you to search for and select an account record, and then displays all of the account's related 

opportunities, so type "Opportunities by Account" in the App Name field.

Click the appropriate radio button and select an app type.

Single Object List apps allow you to retrieve data from a single object, such as Accounts. If 

you need to retrieve data from more than one object, you will need to create a Parent Child 

app. For this example, you need to retrieve data from both the Accounts object and the 

Opportunity object, so select Parent Child and click Next. Now, you will select the parent 

object and fields to use in the app.
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3.  

4.  The parent object for your app will be the Account object, so click the Parent Object drop-

down menu and select Account. The Account fields are displayed in the field list.
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4.  

5.  

6.  

Notice that the two primary fields are selected by default. Select the Account fields that you will use in 

your app. Click the check box next to the following fields:

• Type

• Region

• Owner

• Industry

• Website

You can find fields by scrolling through the list, but it might be easier to use the 

Search Fields feature. Just type the field name or field ID in the search box. You 

can also sort the fields by Data Type by clicking on the top of the Data Type 

column.

Click Next.



X-Author for Excel February 2017 Designer and Runtime Guide

67 Copyright ©2011-2017 Apttus Corporation. All rights reserved.

6.  

7.  

8.  

The child object for your app is the Opportunity object, so click the Child Object drop-down 

menu and select Opportunity. The Opportunity fields are displayed in the field list.

Select the Opportunity fields to be used in your app. In a child object, the primary lookup 

field is also preselected. For this app, you want to allow the user to add new opportunities, 

so you must select all the required fields for creating a new opportunity record. (With Quick 

App, this only applies to the child, not to the parent. When creating apps using X-Author 

Designer, the app can include an ability to create both parent and child records 

simultaneously.) For this example, the following additional fields are required, so click the  
check box next to each of these fields.

• Amount

• Close date

• Stage
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8.  

9.  

Click Next.

Now we go to step nine, where we decide which fields to display on the Excel workbook, 

which fields to allow your users to save back to Salesforce, and which method to use to get 

the data from Salesforce.

Select the fields that you want displayed to the user in the Excel workbook. Notice that both 

the owner ID—which we previously selected—and its lookup name are available. You can 

select all the fields by clicking the Display Fields check box in the Select All section (you can 

change their display order later), or you can individually select the fields in the order you 

want them displayed. The parent object fields will display vertically in Excel. For your app, 

select the Display fields shown in the illustration below.
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9.  

10.  Next, specify which fields your users can update and save back to Salesforce by clicking the 

corresponding check box in the Save column. Once again, you can use the Save Fields 

check box in the Select All section or individually select the fields. Notice that you cannot 

select fields that were not specified as Display fields in the previous step. For your app, 

select the following Save fields.
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10.  

11.  Specify how to retrieve the data from Salesforce by selecting an option from the Data 

Criteria drop-down menu. For the parent record, Quick App provides only one option, User 

Selection, which allows the user to input search criteria, view the search results, and then 

select the record they want to retrieve from Salesforce. This assumes you are opening the 

app from Excel. If you open the app by launching it from an account page in Salesforce, then 

that account is automatically selected as the parent record.
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11.  

12.  

This is how the Display fields will appear when you run the app and retrieve data from 

Salesforce.
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12.  

13.  

Specify the fields that you want your app users to be able to use as search filters when they 

click the corresponding check box in the Search Fields column. For this app, select the 

following Search fields.

Specify the fields that you want to be displayed in the search results by clicking the 

corresponding check box in the Result Fields column. For this app, select the Result fields 

shown in the following illustration.
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13.  

14.  

Did you know...?

By specifying fields to be used as Search Fields, you just created filters. In the 

upcoming steps, you will see how to add other filters based on the fields that 

weren't selected as Search Fields.

Next, you will add two filters that will allow users to further filter search results. Start by 

clicking the Filters button. The Filters window opens.
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14.  

15.  

16.  

17.  

Notice that the three fields you specified as Search Fields are already present as User Input 

filters. You are going to add two more filters now, one to show only those opportunities in 

manufacturing, and another to allow your app users to further filter opportunities by region.

Click the Add Row button to add a new filter.

In the new row, click the Salesforce Object and Field button (  ) to select a field.

Double-click the Region row to add that field to your filters.
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17.  

18.  

19.  

20.  

.

For your app, you only want to see those opportunities that are in the Manufacturing 

industry, so click the Value drop-down menu in the Industry row and select Manufacturing.

Follow the same process to add another filter. This time, choose the Region field to filter on.

Change the Value Type to User Input and, instead of setting a value, change the Operator 

from "equals" to "in  so your users can select from the drop-down list and filter data by "
region.

Now your filters should look like this.
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20.  

21.  

22.  

By default, filters are all related by the AND Boolean condition, which means that, in 

this case, all five of these conditions must be met for a record to be returned as a 

search result.

To change the way the filters are related, you can add Boolean logic to the filters by 

clicking the Add Filter Logic button. Filter logic in X-Author for Excel works the 

same as it does in Salesforce.com. .Learn more

Click Save.

This is how your search filters and results fields will look when you run the app.

You are done configuring the parent object, so click Next to move on to the child object, 

Opportunity.

https://help.salesforce.com/htviewhelpdoc?id=working_with_advanced_filter_conditions_in_reports_and_list_views.htm&siteLang=en_US
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22.  

23.  

24.  

This window should look familiar to you. It looks different than the window where we 

configured parent-object options (it has fewer columns) because the data criteria is set to 

Query.

If the Data Criteria field is not set to Query by default, set it to Query now.

Select the following Display and Save fields. (Note that the fields from the child object will 

render horizontally.)
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24.  

25.  

Now, you will add two filters to ensure that you see only those opportunities worth a certain 

dollar value and in a particular sales stage.

Click the Filters button.
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25.  

26.  

27.  

28.  

29.  

30.  

31.  

Notice that the parent object is already present as an Input filter. You are going to add two 

more filters to ensure that you see only those opportunities worth more than $20,000 and 

only those that are not set to the stage of Closed Won.

Click the Add Row button to add a new filter. A new row is added.

In the new row, click the Salesforce Object and Field button (  ) to select a field.

Click the Amount field and then click Select.

For the Amount field, click the Operator drop-down menu and select "greater than".

In the Value text box, type 20000.
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31.  

32.  

33.  

34.  

35.  

36.  

37.  

Click the Add Row button to add a new filter. A new row is added.

In the new row, click the Salesforce Object and Field button (  ) to select a field.

Click the Stage field and then click Select.

For the Stage field, click the Operator drop-down menu and select "not equal to".

Click the Value drop-down menu and select Closed Won.

Your filters should now look like this.

Click Save.

Click Next. The App Settings window opens.



X-Author for Excel February 2017 Designer and Runtime Guide

81 Copyright ©2011-2017 Apttus Corporation. All rights reserved.

37.  

38.  

39.  

40.  

41.  

42.  

All you have to do now is some label work, allow users to add or delete rows in the 

worksheet, and decide whether the app should be launchable from within Salesforce, and 

you are done.

If this is an app that users will access from a button on a Salesforce page, select the Enable 

App Launch from Salesforce check box. The app you have just built would be a great 

candidate for this because, when the user is on an account in Salesforce and wants to edit 

the related Opportunity list, they can just click on a button and do their editing in Excel. (You 

will also need to do some setup work inside Salesforce, such as putting the button on the 

right page. For more information, refer to Launching an X-Author for Excel App from 

.)Salesforce

In the Worksheet Title text box, type Opportunities by Account. Remember, this title will 

appear in field A1 on your Excel workbook.

Change the Group Label to "Opportunities."

Click the Enable Add Row check box.

Click Finish.
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Congratulations! You've completed your first Quick App. Now, you can preview the app to see how 

.it works

Adding Salesforce Objects to your App

Use the  button to select the Salesforce objects and fields to be used in an app.Salesforce Objects

Object Behavior

All objects used in an app are assigned a behavior and this which determines their availability in 

maps and actions. There are two behaviors:

Individual: Work with an individual record at a time for that object.

List: Work with more than one record for that object.

Default Object Behavior

All objects used in an app are assigned a behavior, which determines their availability in maps and 

actions. Object behavior can be changed at any time by right-clicking on any object once it has 

been added to . There are two behaviors:Selected Objects

Individual: Work on an individual record for that object.

List : Work on more than one record simultaneously for that object.

Object Combinations

Any number of objects can be selected.

The same object can be selected multiple times in different hierarchies if it needs to be used 

in different ways.

A combination of related and unrelated objects can be selected.
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1.  

2.  

Changing Objects

Removing an object will invalidate any maps and actions in the app. You must remove those links 

manually before you remove the object. Generally, if you have selected the incorrect objects and 

have already created maps and actions, you should start over. If it is just unrelated objects that 

need to be changed, then you can remove that object after you correct the maps and actions. Then 

you can add in a new object.

Selecting Fields

Select as many fields as necessary for each object.

The following fields are automatically selected and cannot be deselected

ID

Name, if there is a Name field

Look-up for a parent object that is selected as part of the object hierarchy.

All other fields must be manually selected. The Search Fields box provides a type-ahead 

that searches for fields across both the field ID and field Name columns. The middle column 

displays the field names and is sorted alphabetically. (You can also sort the fields in data 

type order by clicking at the top of the data type column.)

You must click Apply to save your field selections as you move between objects. When you 

are done with all objects, click Save and Close.

When a picklist field is selected, all picklist values will automatically be retrieved during 

runtime. Regular, dependent and multi-select picklists are supported.

To add objects and fields

In the ribbon menu, click the Salesforce Objects button. The Select Objects window opens.
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2.  

3.  

4.  

From the Objects Hierarchy section, select an object or drill down to other objects by clicking 

the next to the object name.+ 

To select one object, click Add Parent Object to move the object to Selected Objects.

To add one or more nested objects, click Add Child Objects to add all child objects below the 

parent object.
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4.  

5.  

6.  

7.  

When you select Event Object from the Salesforce Objects dialog in X-Author for 

Excel Designer and Runtime editions, you can now select fields of type Subject of 

datatype Editable picklist.

Additionally, In Salesforce a lookup field can belong to multiple objects, for e.g : 

Task Object > Related To Field (What ID) and Contact Field (WhoID) are multi-

objects lookup. We now support multi-object lookups in X-Author for Excel.

Object behavior can be changed by right-clicking on an object in Selected Objects.

In the Select Fields section, click the check box next to at least one field for a selected object 

to add fields to your app.

Primary fields are selected by default and cannot be deselected.
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7.  

8.  

Click Apply.

After you have selected all of the objects and fields you need for your app, click Save and 

Close.
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8.  

The Salesforce objects and fields for the app have been selected and saved and are available to 

be used in maps and actions.

You can now create maps or actions.
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Linking Salesforce fields to Excel cells

Display Maps are accessed from the Display Map button in the ribbon menu. A Display Map is 

used to link Salesforce fields to Excel cells for data that will be retrieved from Salesforce. When 

data is retrieved from Salesforce using one of the X-Author data-getter actions, it is temporarily 

stored in Excel memory before being placed into the worksheet. X-Author then uses a Display Map 

to place the data in the correct Excel cells.

Each field from Salesforce Objects can be linked in a Display Map and is presented by the object 

behavior types (Individual and List).

This section comprises the following sections:

To create a Display Map

To edit an existing Display Map

To delete an existing Display Map 

To add Individual Object fields to a Display Map

To add List Object fields to a Display Map

The following table describes the display map features.

Unlimited 
Display 
Maps

There is no limit to the number of Display Maps in a single app.

Unlimited 
Objects

A Display Map can include fields from multiple objects.

Multiple 
Worksheets

A Display Map can cross worksheets, but not workbooks.

Changing 
Layout

You can insert columns or rows after you have created a Display Map. When 

you save the app, the cell locations in a Display Map are adjusted based on the 

new layout. If you need to move a field, please see Moving and Removing Fields
.
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1.  

2.  

Template 
Presentation

To prepare the template for the end user once a field has been mapped, place 

your cursor in a cell and delete the value in the brackets using the  key. Delete
Do not delete the row.

Removing 
Fields

To remove selected fields from Excel, select the fields from the  Mapped Details
section in the bottom right hand window of the Display Map and click Remove 

Fields. If you remove a field that is already part of a Save Map, a warning 

message is displayed that the field will be removed from the Save Map as well. 

Do not delete a field from the worksheet in any other way, otherwise the name 

range that governs that field will not get properly removed.

To create a Display Map

You must have at least one object selected in Salesforce Objects menu.

In the ribbon menu, click Display Map.

 

Click Create. The Display Map panel opens in Excel.
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2.  

3.  

4.  

5.  

In the Name field, type the display map name.

Select an object type from the Type picklist menu to see the fields for those objects.

Objects are listed based on the object behavior from Salesforce Objects: Individual 

or List. Individual fields are displayed by default. You can switch to List fields from 

the Type list.
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5.  

6.  

Add a field to the Display Map by dragging it from the Display Map panel and dropping it on 

the worksheet. Fields can be searched by using the Search box.
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6.  

7.  

8.  

1.  

2.  

3.  

Click Save.

 

Click Close.

Save the application by clicking Save Application.

You have created a Display Map.

To edit an existing Display Map

In the ribbon menu, click Display Map.

From the list of existing Display Maps, select one and click Edit.

Make appropriate changes and click Save and Close.

The updated Display Map is saved.

To delete an existing Display Map
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1.  

2.  

1.  

2.  

1.  

2.  

3.  

To delete an existing Display Map

Note

You cannot delete a Display Map that is being used by a Display Action.

From the ribbon, click the Display Map button.

From the list of display maps, select a display map and click Delete.

The Display Map is deleted.

To add Individual Object fields to a Display Map

In the Display map dialog, set the Type field to Individual. All Individual objects and their 

fields will be displayed.

Drag the field from the Display Maps panel and drop it in a cell on the worksheet.

You can place the field anywhere on any worksheet except in the same row 

that contains fields from a List object.

Based on the , you can also select any field from a  hierarchical navigation

related list object and drag it.

The mapped field is displayed in brackets and the field label will display on the left. The mapped 

field/cell link is displayed in Mapped Details.

To add List Object fields to a Display Map

From the Type picklist, select List.

Click the Vertical radio button. (Horizontal layouts are covered later in this section.)

Drag the field from the Display Map panel and drop it in a cell on the worksheet.
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When fields from List objects are mapped, they form a list range. Based on the hierarchical 

, you can select any field from a related list object and place it in the same row. They do navigation

not need to be placed adjacent to each other, but there must be a start and end cell that represent 

the list range. For example, you could have mapped fields in A5, C5, and F5 with formulas in B5, 

D5, and E5.

The mapped field is displayed in brackets and the field label will display above. The mapped field

/cell link is displayed in Mapped Details. For more information about List objects and ranges, refer 

to .List Ranges

Hierarchical Navigation

There are various areas within the Designer where hierarchical navigation is used. Fields can be 

added to the Display Map from either the object listed in the window or from a related object in an 

object hierarchy. The objects and the specific fields required for the Display Map must have all 

been selected in Salesforce Objects.

To add a field from the listed object, click on a field, hold the left mouse button down, and drag it 

onto the worksheet. To add a field from a related object, click on a + key (designates a related 

object is available) and navigate to the object.

You can now edit the parent object fields in the hierarchy from the same display map. In order to 

enable this feature, you must drag and drop the appropriate fields from the parent object to your 

display map. For example, Account is the parent object and Opportunity is the child object, then 

you can update the Account object fields and Opportunity object fields from the same display map. 

Then, you can simply edit and save your data in the entire hierarchy during runtime.

List Ranges

This section contains the rules and guidelines that apply to the use of list ranges.

Must include 

the record id if 

you are 

planning to 

save data

If you are planning to save back to Salesforce any data that has been 

retrieved into a List Range, you must include the record ID somewhere 

in the range. The best place to put this field is at the end of the range 

but it can be placed anywhere.

The record ID is used to make sure that the Excel rows and Salesforce 

records remain connected should the end user sort data in the range.

https://documentation.apttus.com/display/XAEAUG15/Hierarchical+Navigation
https://documentation.apttus.com/display/XAEAUG15/Hierarchical+Navigation
https://documentation.apttus.com/display/XAEAUG15/List+Ranges
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1.  

2.  

3.  

4.  

Formulas in a 

List Range

Formulas can be added into either mapped or non-mapped cells in a 

List Range.

Formulas are inserted into the List Range cells as each record is 

retrieved into the worksheet via the Display Map.

Formulas in cells where Salesforce data is being retrieved and 

displayed will be overwritten by the Salesforce data but are still very 

useful if you allow users to add rows. This is covered in Adding Rows to 
.Worksheets

List Rows are 

Inserted

As each List Salesforce record is retrieved and displayed, an Excel row 

is inserted in the workbook.

Anything you have placed below or alongside a List Range (for 

example: a total formula below the range or a pivot table), is pushed 

down accordingly.

Fields from 

related objects

Fields selected from related objects in the hierarchy (see Hierarchy 

Navigation above) can also be included on the same row in the List 

Range.You can elect to save related object fields by including them in 

the Save Map. See  for more information.Save Maps

List Ranges for 

different objects

These can be created below other ranges or on other worksheets.

List Range Sorting and Grouping

For List ranges, you can set some basic sorting and other settings in the Options tab. The native 

Excel sorting and grouping options are more flexible in many cases.

To sort and group List Ranges

Select List from the Type field.

Click the Options tab.

Type a description in the Header field to display above the label row of the list range.

https://documentation.apttus.com/display/XAEPOWFEB16/Save+Maps
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4.  

5.  

6.  

In Sort by Field 1 and Sort by Field 2, select an individual column to sort by.

In Group by Field 1 and Group by Field 2, select a column in the repeating range to group 

by. These fields should be at the leftmost side of the list range.

Click Save.

Sorting and Grouping Options have been selected and saved.

From the May release onwards, for both single and two levels of grouping in Display Maps, we 

support the following

You can now total all numbers, decimals and currency fields

You can now create totals on all Formula fields. Totals is displayed for formula fields having 

datatype as number, decimal and currency.
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Vertical and Horizontal Layouts

Records in a List object can be displayed either vertically or horizontally. In vertical layouts, 

records are presented as rows with each column being a field. For horizontal layouts, each record 

is a column and the rows are represented by the fields. The steps are the same as you would use 

to , but select the Horizontal radio button instead of the Vertical radio button.create a Display Map

Horizontal Layout Restrictions

Records can be retrieved and updated but you cannot add or delete records.

Field Lookups

Field lookups (also referred to as Look Aheads) allow designers to create field lookups for runtime 

users. For example, when a user is adding an opportunity, they can look up the account name. 

There are two types of lookups and both are initiated from double-clicking a cell. FieldMapping 

source fields are populated from selected search and select action's result fields. FieldMapping 

target fields are populated from the selected retrieve map's selected repeating group.

Online: these lookups are real-time Salesforce data and are more flexible than offline. See 

the procedure for details.

Offline: these lookups are for data that is already available in Excel (it might have been 

placed there from any source). For example, from a data invoking action (Query or Search 

and Select), data that was already in the template, or data that is generated from a macro 

into a list and made available to the offline lookup feature.

Prerequisite

Before creating a field lookup, you must have an existing field mapping in a Display or 

Save Map.

https://documentation.apttus.com/display/XAEPOWFEB16/Display+Maps
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1.  

2.  

3.  

4.  

5.  

6.  

7.  

To create an online lookup

A Search and Select Action on the object that corresponds to the lookup value field must exist. For 

example, if you need an account lookup, there must be a Search and Select Action on the Account 

object.

Click Display Map.

Select a display map and click Edit. The Display Map panel opens.

In the Mapped Details section of the Display Map pane, click  to open lookup properties 

for that field.

Click the Search And Select Action tab.

Select the applicable Search and Select Action.

To set Online Lookup as the default lookup method, select the Is Active check box. Either 

Offline or Online lookup can be active at a given time. To provide an online lookup when the 

user is online and an offline lookup when the user is offline, create both types of lookups and 

select the Is Active check box in the online lookup.

In the Mapped Record ID field, select the record ID field and click Save.

This ensures that the correct lookup will be returned to the record. To remove an existing 

Online Lookup, click Remove.
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7.  
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7.  

8.  

1.  

2.  

Click Close.

To create an online lookup where new rows are added for each record 
selected in the lookup

The Enable Field Mapping check box allows you to design a lookup where the data is fetched from 

the Search and Select Action. The check box also enables you to add new rows and data for each 

record selected by the user in the record search.

Follow the steps to create an online lookup and also click Enable Field Mapping.
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2.  

1.  

2.  

3.  

4.  

For each field in the Search and Select Action, select a corresponding Target Field from the 

Display Map.

The Enable Field Mapping check box in a look ahead dialog allows you to design a look 

ahead where the data is fetched from the Search and Select Action. The check box 

enables you to add or replace new rows and data for each record selected by the user in 

the record search.

In the Result Selection of the Search and Select action, decide whether the user can 

select a single or multiple results that are returned to Excel, and select a Result selection. 

(You can only select Multiple for a List object.). You can set any of the following options:

Single: Replaces the selected record.

Multiple: Creates a new record.

To create an offline lookup for single column

Click Display Map.

Select a display map and click Edit. The Display Map panel opens.

In the Mapped Details section of the Display Map pane, click  to open lookup properties 

for that field. The X-Author Designer window opens.

Click the Excel tab and from the Column Mapping section, select Single Column.
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The single-column option must be used only when the list of values does not 

contain duplicate lookup values because it returns only the lookup value. If there 

are duplicates, the first value found in Salesforce is populated in the lookup field, 

and that may not be the value intended by the user.

Enter the range representing the lookup values. This can be done in the following ways.

In New Range, type the single column cell range that contains the list of values to be 

searched and click Save to save the data source.

Highlight the list values in the worksheet and click Get Current Selection.

To make offline lookup the default lookup method, select the Is Active check box. Either 

Offline or Online can be active at a given time.

To provide an online lookup when the user is online and an offline lookup when the user is 

offline, create both types of lookups and select the Is Active check box of online lookup. 

When the user is online, the Online Lookup will be active. When the user goes offline, the 

offline lookup will automatically become active.

The first time a lookup is initiated by the end user, the lookup function loads data 

from the worksheet and stores it in the Lookup window for quick results on 

successive lookups. If you expect changes in lookup data, then refresh the lookup 

fields every time you load the lookup by selecting the Refresh on Every Data 

Loadcheck box.

Click Save.
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To create an offline lookup for multiple columns

Click Display Map.

Select a display map and click Edit. The Display Map panel opens.

In the Mapped Details section of the Display Map pane, click  to open lookup properties 

for that field.
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Click the Excel tab and, under the Column Mapping section, select Multi-Column.

Note

This is the preferred lookup option for offline lookups because it handles duplicate 

lookup values correctly.

Enter the range representing the lookup values. This can be done in one of the following 

ways.

In New Range, type the multicolumn cell range that has the list of values to be 

searched and click Save to save the data source.

Highlight the list values in the worksheet and click Get Current Selection.

Your range must always include the record ID of the lookup value (for example, Account ID).

The column identifiers appear in the display columns.

Select the Primary Return Column. This is the column that matches the lookup value (for 

example, Account Name).

Select the Secondary Return Column. This must always be the column that has the record 

ID of the lookup value.

Select the Target Field. This must be the record ID field for the lookup name.

To make the Offline Lookup the default lookup method, click the Is Active check box.

: Either Offline or Online can be active at a given time.Note

To provide an online lookup when the user is online and offline lookup when the user is 

offline, create both types of lookups and click the Is Active check box for online lookup. 

When the user is online, online lookup will be active. When the user goes offline, the offline 

lookup will automatically become active.
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The first time a lookup is initiated by the end user, the Lookup function loads data from the 

worksheet and stores it in the Lookup window for quick results on successive lookups. If you 

expect changes in lookup data, refresh the lookup fields every time you load the lookup by 

clicking the Refresh on Every Data Load check box.

Rich Text Fields

When a Salesforce field is of type Rich Text, that field can be edited in Excel using a rich-text 

editor that opens as a new panel.

Note

Rich-text editing is supported only for List objects.

When you are designing an app, you add rich-text fields the same way you would add any field.

When running an app, rich-text fields appear as Click here to Edit link.

Rich-Text Editor will not be loaded or is not supported of a rich-text field is added as a save-only 

field in the repeating group and if a rich-text field is added as an individual retrieved field or as an 

individually save-only field.

To edit field data when running an app

Do one of the following:

Click Click here to Edit to edit a field that already contains data.

Click Click here to Add to edit a field that does not contain data.

The rich-text editor opens.

Edit the field data.

Click the Save to Excel button to save the changes to your Excel spreadsheet.
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3.  

4.  Save the changes to Salesforce.

Working with Fields and Columns

This section outlines the procedures to move, edit, and delete fields and columns.
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Moving and Removing Fields

X-Author can easily adjust its map links when fields need to be relocated, provided these changes 

are performed correctly. The only way to properly remove a field from a Display or Save Map is 

through the Remove Fields function in the lower right section of the map. Deleting the cell contents 

by placing your cursor in the cell and clicking Delete will have no impact and using Excel's native 

delete row or column functions will corrupt the app.

If you remove a field from a Display Map that is already part of a Save Map, a warning message is 

displayed that the field will be removed from the Save Map as well. Do not delete a field from the 

worksheet in any other way; otherwise the name range that governs that field will not be properly 

removed.

To Remove a Field from a Display Map

Click Display Map.

Click Edit for the display map you want to remove the field from.

In Mapped Details select the field to be removed. If you want to remove all the fields, select 

the check box next to the left of the Name column.

Click Remove Fields.
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Click Save.

Click Close.

To Move a field from one cell to another

Close all Display Maps.

Place your cursor in the cell to be moved. Right mouse click and select Cut.

Place your cursor in the target cell. Make sure there is not already a mapped field in that cell. 

Right mouse click and select Paste.
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The label (which may be above or alongside the field) will also need to be moved or just re-

entered. Moving the label does not move the data field itself. You can simply drag the label 

to the new location, it has no impact on the Display Map.

Click Save App. It is this last step that relocates the mapping so you must save the 

application after you do any moves.

Now you can open any Display Map and the adjusted locations will be visible in .Mapped Details

Inserting and deleting columns and rows

This section provides the procedure to insert or delete columns or rows.

To insert or delete Columns or Rows

Click Save App.

Close all Display and Save Maps.

Insert or delete columns or rows.

Click Save App.

Now you can open any Display Map or Save Map and the adjusted locations will be visible in 

.Mapped Details

To move a column

Highlight the column. Right mouse click and select Cut.

Highlight the target column. Right mouse click and select Paste.

Click Save App.

To search fields in the Display Map and Tree View

Click Display Map.

Click Edit for the display map whose fields you want to view.
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Enter the name of the field or option you want to search for in the Search text box. The 

Search operation occurs in the tree view as well as on Mapped Details simultaneously. The 

Tree view of objects is collapsed. As you start typing in the search bar, the tree view 

expands to display fields matching the searched key word.In the Mapped Details table, the 

displayed rows are limited based on the searched key word.

To resize the Display Map and Mapped Details area:

Click Display Map.

Click Edit for the display map you want to verify the resize feature for.

Click and drag the horizontal line between the Tree view and Mapped table upwards or 

downwards to resize the Tree view or Mapped table area.
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Adding and Updating Records to Salesforce

This section covers the following procedures:

Updates

Inserts

Deletes

Working with Save Maps

To create a Save Map 
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To edit an existing Save Map

To delete an existing Save Map

Creating Preloaded Grids

To create a Preloaded Grid

Save Maps are accessed from the Save Map button in the ribbon menu. Save Maps are used to 

link Salesforce fields to Excel cells for data that is to be saved to Salesforce. X-Author for Excel 

supports updates, inserts, upserts, and deletes.

Updates

Updates assume that records were retrieved from Salesforce and the data from one or more fields 

in that record were placed on the worksheet via a Display Map. Using the Display Field function in 

a Save Map, user modifications to any cell are updated on the record.

Even though a record was retrieved via Salesforce, and the data from one or more fields in that 

record were placed on the worksheet via a Display Map, you might also want to update a field that 

was  retrieved. In this case, you can use the Other Field function. Since no value is retrieved not
from Salesforce for this field, it will always be updated to the value in the Excel cell.

Inserts

New records can be created in three ways:

When a new data row has been added by the user via the Add Row menu button

When the App automatically adds a new data row via the Add row Action + pasting data into 

that new row.

Using the preloaded grids feature (see the procedures below)

Deletes

Rows can be deleted from Display Map lists by the user clicking the Delete Rows from Salesforce 

menu button. To delete one or more records from a List, the Display Delete Row from Salesforce 

must be checked in User Menus and there must be a Save Map with at least one field in it.
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Working with Save Maps

This section provides the procedure to create a Save Map. The table highlights the features of 

Save Maps.

Unlimited Save Maps There is no limit to the number of Save Maps.

Unlimited Objects A Save Map can include fields from any number of objects.

Multiple Worksheets A Save Map can cross worksheets (but not workbooks).

To create a Save Map

On X-Author ribbon, click Save Map.

Click Create. The Save Map pane opens on the right side of Excel.

Type a Name for the Save Map. If you are just creating one Save Map, you can just use  Map
or any other name. If you are using multiple Save Maps, then you need a more descriptive 

name to identify each one.

Add fields to the Save Map.

If you want to save data that has been retrieved via a Display Map and modified by 

the user, click Add Display Map Fields and select the fields to save. You can use the 

filter to narrow down the field list, and then click Apply.
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For other cell data (not retrieved) that needs to be saved, you use the Add Other 

Fields functionality to map the cell to a Salesforce field. Click Add Other Fields. Select 

Individual or List to display the objects you need and then drag the field to the cell. 

Click Add to Save Map.
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Add Matrix Map Sections allows you to add any specific sections of the matrix maps.
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Click Save.

Click Close.

Click Save App.

To edit an existing Save Map

Click Save Map.

From the list of existing Save Maps, select one and click Edit.

Make the desired changes and then click Save.

Click Close.

The modified Save Map is saved.

To delete an existing Save Map
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To delete an existing Save Map

You cannot delete Save Maps that are used in a Save action.

Click Save Map.

From the list of existing Save Maps, select one and click Delete.

The Save Map is deleted.

Creating Preloaded Grids

There are three ways to add records to Salesforce.

Click Add Row during runtime.

Copy and then the X-Author Paste Values or Paste All functions.

Rows can be added in the Designer that become added rows automatically in runtime 

without the user having to take any action.

A preloaded grid can only be used to add new records, not for retrieval and update. For example, 

you might have a six-row-by-three-column grid with three rows of formulas and an empty row 

between each. The formulas recalculate based on values elsewhere in the workbook. You want 

each of the three rows to be inserted as Salesforce records each time the input values change and 

the user clicks Save.

To create a Preloaded Grid

In a Save Map, click on Show Preloaded Grid.

In the Preloaded Grid window, select the List Object for which you are creating the grid.

Enter the number of rows for the Preloaded Grid.

Click the check mark when finished. The object will now have an identifier in brackets for the 

number of rows added. To change the number of rows, enter in a new number in Preloaded 

Rows.

Click Save.
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Customizing the App Experience

Actions are used to create a specific user experience. They include being able to query data, 

display and save it as well being able to manipulate it within the workbook.

The top section of the Actions menu button provides access to existing Actions. Click the down 

arrow at the bottom of the button to create new Actions.

Click on the Action name in the following table for more information on the action.

Action Name Action Type

Add Row Action Adds a row to the top or bottom of your Display Map.

Check-In Saves the Excel file to Notes and Attachments in Salesforce and 

unlocks the file.

Check-Out Opens a previously saved X-Author for Excel file from Salesforce 

Notes and Attachments and then locks the file to prevent editing by 

any other user.

Clear Clears cell data.

Dataset Action and 

Other Functionality to 

Overcome 20K SOQL 

Character Limit

Combines outputs of Query Actions to overcome SOQL limitations.

Display Places retrieved data in the worksheet based on a Display Map.

Macro Runs an existing macro.

Paste Action Counts the rows from which data has been copied and then pastes 

the copied data into those rows.

Query Queries data from Salesforce.



X-Author for Excel February 2017 Designer and Runtime Guide

121 Copyright ©2011-2017 Apttus Corporation. All rights reserved.

Action Name Action Type

Salesforce Method Calls a Salesforce Method.

Save Saves worksheet data to Salesforce based on a Save Map.

Save Attachment Saves the entire Excel file or specific worksheets in the Excel file to 

Notes and Attachments as an xls or pdf.

Search and Select Allows a user to search for and select data that will then be retrieved 

into the workbook or that will provide a filter to a subsequent search 

or query. Retrieves data from Salesforce based on the user record 

selection.

Switch Connection Switches between orgs to allow uploading and downloading data 

across multiple orgs.

Add Row Action

The  lets you automatically add rows to the top or bottom of your spreadsheet as Add Row Action
part of your flow. You can add a row containing data from a specified set of cells or from another 

action flow step, or you can add a specified number of empty rows and allow users to insert the 

data.
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2.  

To create an Add Row action

In the ribbon menu, click the Actions drop-down menu and select Add Row. The Add Row 

Action window opens.

Complete the fields described in the following table.

Field Description

Name Type a name for the new action.

Save 

Map

Select an existing Save Map to use when adding rows.
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List 

Object

Select the list object that you will be adding rows for.

Location Specify whether to add the new rows before the existing data or after it.

Input 

Type

Select the method used to determine how many rows will be added.

Action Flow Step Input – The number of rows added will be determined by the 

outcome of a previous step in the action flow. For example, if you have a 

Search and Select action in the flow, the number of rows added will equal the 

number of rows selected during that step.

Cell Reference – Select this option to specify the workbook cell, such as 

Sheet3!A1, that contains the numerical value of the number of cells you want to 

add.

Number of Rows – Select this option to specify a static number of rows to add.

User Input – Select this option to allow the runtime user to specify the number 

of rows to add.

Click Save.
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Check-In Action

Check-In action saves the Excel workbook to the Notes and Attachments of a designated record 

and then unlocks the workbook and enables it to be checked out by another user.

To create a Check-In action

At least one object must be identified as  in Salesforce Objects.Individual

Click the lower section of the Actions button and select Check-In.

In the Action Name field, type a descriptive name for the action.

From Object, select an object and click Save. The list of objects will include any Individual 

Salesforce Objects.

In the File Name, select the option to type the file name that will be used when the file is 

checked-in.

Field Name Description

Use Runtime 

Filename

Select this option to allow your user to enter the File Name at run time.

Select this option to allow your user to enter the File Name manually. 

Enter the file name manually.
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Field Name Description

Manually 

Provide File 

Name

Use Cell 

Reference as 

File Name

Select this option to allow your user to use cell reference as File Name. 

Select the cell and click the icon. Note: This feature is not available 
with Presto apps.

A Check-In action has been created.

Check-Out Action

This action provides the runtime user with a list of all files previously checked into the designated 

object/record and they can select one of those files to open. This then locks the file for other users 

until it is checked back in by the current user.
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To create a Check-Out action

You must have at least one object identified as  in Salesforce Objects and at least one Individual
Check-In action.

Click the lower section of the Actions button and select Check-Out.

In the Action Name field, type a descriptive name for the action.

From Object, select an object and click Save. The list of objects will include any object 

marked as Individual in Salesforce Objects.

A Check-Out action has been created.
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Clear Action

A Clear action clears the cells in the workbook for a specified Save Map. It is used when, for 

example, you are adding a record to an Individual object using a form and you need to clear the 

cells after each record has been added so you can add the next one. Another example would be 

when you want to combine process creation and editing in the same app, like quoting.

To create a Clear action

Click the down arrow on the Actions button and select Clear from the drop-down menu. The 

Clear Fields Action window opens.

In the Action Name field, type a descriptive name for the action.

From the Display/Save Map picklist menu, select an existing map.

Click the check box next to the object to be cleared and it will be displayed in Selected 

Objects.

Click Save. You can select additional Save Maps and objects as necessary.
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A Clear action has been created.

Dataset Action and Other Functionality to Overcome 20K SOQL Character 
Limit

Salesforce has various query limitation as follows:

SOQL statements cannot have more than one level of sub-query

Sub-queries cannot be executed when there is an 'OR' clause in the filter.

SOQL statements cannot exceed 20,000 characters in length.
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If your query exceeds 20K characters, an SOQL error appears stating the query cannot exceed 

20,000 characters in length. X-Author helps overcome these limitations using a combination of 

automated functionality and the Data Set Action (simulates a SQL union function)

X-Author checks the queries in runtime and automatically runs sub-queries and data chunking 

functionality to overcome a >20K character query. If during testing you find that even this is 

insufficient, then create a Data Set Action where you can break the query action into multiple query 

actions and use the query output as an input to the Data Set action.

Using the Data Set Action, you can merge the output of two queries into a single Data Set based 

on the OR clause or AND clause. When you specify 'OR' clause for query outputs, one output Data 

Set is created by union of the two query outputs. When you specify the AND clause for query 

outputs, one output Data Set is created by intersection of two query outputs.

Prerequisites for creating a Data Set Action

For all queries that cross the limit of 20K, split the query into separate query actions. Ensure 

that your split query meets the following criteria:

If there are 2 'IN' filters or 'NOT IN' filters and if the query crosses the limit of 20K, 

ensure that you:

Separate the 'IN' clause from the query and create a different query action.

Create 2 separate Query Actions each having a single 'IN' filter.

While creating an action flow and selecting a query action, ensure that ‘Persist 

Data in Output’ checkbox is selected.

Using the Data Set action procedure below, merge the data retrieved by both 

the query action in a single Data Set using a Data Set Action. You can choose 

to use the 'OR' clause or 'AND' clause to merge the data into a Data Set.

If there are 2 or more 'IN' filters or 'NOT IN' filters and if the query crosses the limit of 

20K, ensure that you:

Separate the 'IN' clauses into a separate query action.

While creating an action flow and selecting a query action, ensure that ‘Persist 

Data in Output’ checkbox is selected.
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Using the Data Set action procedure below, merge the output of those query 

action flows using a Data Set Action into a single data set.

Ensure that the application type is . The Data Set Action can be only executed Power Admin
on applications having the Power Admin edition.

To create a Data Set action

Click the downward arrow of the Actions button and select Data Set.

Enter an Action Name. Use a descriptive name, For example, Data Set Product Name.

From the Object drop-down list, select an Object. The object of the Data Set must be the 

same as those of the split Query Actions.

Specify the operator for the Data Set as AND or OR. The output of the different queries are 

merged into the Data Set either as a union or an intersection.

Navigate to Action Flows, do any of the following:

To create a new Action flow, click Create, specify a name for the action flow. Click Add 

a step.

To add a Data Set to an existing Action Flow, select the existing Action Flow and click 

Edit. Click Add a Step.

Enter the Step Name.
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Before you create a Data Set action step for an Action flow make sure that steps for 

Query Action exist.

Select the Data Set Action. The Data Set Action that you specify must have subsequent 

Query Action flows created for it based on the object you select which Query Action and 

Data Set Action Creation.

Specify the name of the Data Set Action Output.

Ensure that you select the Provide Input and Persist Data in Output check boxes.

In the Action Input Area, specify the query actions from which the output is merged.

Click Apply.
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Delete Action

Using this Action, you can delete records for an object based on specific filter criteria. You can 

delete records for only those objects referenced in the Save Map having Display Map fields along 

with Save other fields. If you do not specify any filter criteria, all the records for the object are 

deleted. You can specify a maximum of 20 filters. Delete action is supported only on Enterprise 

and Power Admin Editions.
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To create a Delete Row action
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1.  In the ribbon menu, click the Actions drop-down menu and select Delete. The Delete Action 

window opens.
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Complete the fields described in the following table.

Field Description

Name Type a name for the new action.

Save Map Select an existing Save Map to use when deleting rows.

Object Select the object that you want to delete the records for.

Specify the filters based on which you want to delete the records. For example, you can 

choose to delete records if the Approval Status of the record is Rejected. Operators are 

supported based on the datatype of the field, such as equals, not equal to, greater than, 
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greater than equal to, less than, and less than equal to. IN and Not In operators are not 

supported in this release. Only Static value type is supported in the May 2016 release.You 

can specify a maximum of 20 filters.

Filters are displayed based on the following conditions:

Save map containing only display map fields will show all filter fields.

Save map containing display and save other fields both will show all fields.

Save map containing only save other fields shouldn't show anything.

Empty columns that are a part of the display map also appear in the filter fields.

To ensure that the user knows that a delete action is executed at runtime, the Prompt 

Configuration Message Before Deleting records check box is selected by default. If the user 

clicks Yes, the records are deleted and the next action in the action flow is executed. If the 

user clicks No, the next action in the action flow is executed.

Click Save.

Display Action

When data is retrieved from Salesforce, it remains in memory until a Display Action places that 

data into the workbook based on a Display Map.

Note: To create a Display Action, you must have an existing Display Map.

To create a Display Action

Click the lower section of the Actions button and select Display.
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1.  

2.  

3.  

In Action Name, type a name. If you are just creating one Display Action, you can use 

Display. If you have more than one Display action, then you may need a more descriptive 

name to identify each.
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3.  

4.  

1.  

Select the Show Query Filters check box and select the Display Map for which you want to 

display the query filters for during runtime. Specify the Filter Location where you want to 

display the query in. For example, specifying the filter location as  displays the Sheet2!B2
query filters in the B2 cell of Sheet 2.

You can also specify a named range as a filter location.

From Display Map, select an existing Display Map and click Save.

A Display action is created.

Runtime Behavior: When the App is executed during runtime, the query filter is displayed in 

Sheet 2 in cell B2. The query filters can also be displayed in merged cells, such as filter location 

supports merge cell.

Macro Action

A Macro action executes a macro from the workbook. It can be executed at any time during an 

Action Flow and it can also be used to conditionally stop the next step in an Action Flow from 

executing.

To create a Macro action

To create a macro action, you must have an existing Macro in the Excel workbook.

Click the lower section of the Actions button and select Macro.
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1.  

2.  

3.  
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5.  

In Action Name, type a value that describes which Macro will be executed.

From Macro Name, select an existing macro.

Select the Terminate Action Flow conditionally if you want to terminate the action flow 

conditionally. The table below describes the behavior of the check box.

Macro Terminate Action Flow conditionally check 
box

Result

True Selected The action flow will be 

terminated.

False Selected The action flow will continue.

Select the 'Disable excel events before macro execution' checkbox.

Depending upon the value of the checkbox, enable or disable the excel events in macro 

action.
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5.  

1.  

2.  

3.  

Paste Action

This action adds rows and pastes data from the clipboard into those rows.

To create a Paste action

Click the lower section of the Actions button and select Paste.

In the Name field, enter a descriptive name for paste action.
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3.  

4.  

5.  

a.  

b.  

6.  

a.  

b.  

7.  

From Save Map picklist menu, select the save map for which you want to create paste 

action.

From the List Object picklist menu, select the appropriate object (of list type).

Do any one of the following:

To add the rows at the top of the current data selection, select Top from Add row 

location.

To add the rows at bottom, select Bottom from Add row location.

Do any one of the following

If you want to paste the rows and its data, select Paste All.

If you want to paste the values only, select Paste Values Only.

Click Save.

A Paste action has been created.
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2.  

3.  

4.  

Paste Data Source Action

This is the automated equivalent of the runtime Paste with Mapping feature and is primarily used 

for migrating data between Salesforce orgs. The manual process would have been to map data 

between source and target orgs using the Source Data function and then use Paste from Mapping 

to copy the data downloaded from the Source org into the Target workbook using the Source Data 

layout.This action automates that process so that the migration can be run uninterrupted.

Prerequisite

You must be using have licensed an edition that includes data migration.

To create a Paste Data Source action

Click on the lower section of Actions button and select Paste Data Source. The Paste 

Source Data window opens.

 

In the Name field, type a descriptive name for the action.

To automatically paste the data from the source file when called from the Action Flow, click 

the Input Source File at Runtime check box.
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4.  

1.  

Click Save.

A Paste Source Data Action is created.

Query Action

The Query action is a point-and-click query builder. This action retrieves data from Salesforce 

based on predefined parameters and/or user input during App runtime. You can create as many 

queries as needed and use them more than once across Action Flows.

Within the Query Action, designers can add many types of query filters that are either hard coded 

or that rely on either user or spreadsheet input at runtime. These filters then can be connected 

using the Add Filter Logic feature.

To create a Query action

Click the down arrow of the Actions button and select Query.



X-Author for Excel February 2017 Designer and Runtime Guide

144 Copyright ©2011-2017 Apttus Corporation. All rights reserved.

1.  

2.  

3.  

4.  

5.  

6.  

7.  

Enter an Action Name. Use a descriptive name, for example, .Query Opportunities

From the Object drop-down list, select an Object.

Type a number in Max Records to specify the maximum number of records to be returned. 

Leaving it blank will return all records unless otherwise restricted by the filters below.

Now add query filters as needed by clicking Add Row.

In Salesforce Object and Field, click the lookup icon  and select a field from the selected 

object or click on an orange lookup field to navigate to a related object and select a field from 

there. To select a field from a lookup object, that object and the field must have been 

selected in Salesforce Objects.

Select a Value Type.

Input: This is for restricting records from the selected object based on a field from 

another object. It also implies that an input is required during an Action Flow. For 

example, retrieve all opportunities for an account that was previously selected by a 

user in a search and select action. X-Author Designer will automatically suggest 

matching fields from the related object. Select the correct field from the drop-down 

list.
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7.  

Static: Type a specific value to restrict which records are retrieved. For example, only 

get records where the geo field equals "West". If you set the Value Type as Static, 

and the operator as in or not in and the query has more than 20,000 characters, the 

query is executed successfully during run-time. If the query condition comprises more 

than 20,000 characters, the query is chunked into multiple queries executed 

separately and the results are assimilated as a single query execution.

System Variables: There are three system variables available for use.

Current User - Used to restrict records based on the user who is logged in.

Current Date - Used to restrict records to the current date.

ExportRecordId - This is used for Apps that will be launched from Salesforce. 

Please refer to that section for usage.

User Input: This will generate a user input field at runtime. This option will present the 

field name to the user at runtime unless you change it as follows:

Hover over the field name and a pop up will be displayed. Change the field name in 

the pop up and click the green check mark. To remove a label, click the red cross 

mark.

If you set the Value Type as User Input, the operator as in or not in and the user input 

query has more than 20,000 characters, the query is executed successfully during run-

time. If the query condition comprises more than 20,000 characters, the query is 

chunked into multiple queries executed separately and the results are assimilated as 

a single query execution.
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7.  

8.  

9.  

Cell Reference: This will filter the query results based on the value of a cell reference 

provided. If you set the Value Type as Cell Reference, and the operator as in or not in 

and the query has more than 20,000 characters, the query is executed successfully 

during run-time. If the query condition comprises more than 20,000 characters, the 

query is chunked into multiple queries executed separately and the results are 

assimilated as a single query execution.

Cell Reference Value Types is not supported in Presto Apps.

Select an Operator. The following table describes combinations of field types, value types, 

and operators.

Click to enlarge.

Formula field types are also supported. The corresponding supported operator 

types depend on the the datatype the formula field returns. The supported return 

types for formula fields are boolean, double, string, currency, percent, and date.

Query and Search and Select Actions now support fields having datatype as email.
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9.  

10.  

Click Add Row to create more filter conditions.

Click Save.

A Query action is created.

Filter Logic

The filter logic is the same as in Salesforce to implement query filters. As an example, for these 

filters, find records that match both the first two filters or the third, For example, 3 OR (1 AND 2) 

has the same meaning as (1 AND 2) OR 3) . For example, find records where the amount is 

greater than “$10 million” AND the close date is earlier than “03/19/2014” OR any opportunity 

where stage equals “Qualification" Amount > 10000000, Close Data < 03/19/2014, Stage = 

'Qualification' You can enter filter line numbers in any order in the Filter Logic text box. See also: 

https://help.salesforce.com/htviewhelpdoc?

id=working_with_advanced_filter_conditions_in_reports_and_list_views.htm&siteLang=en_US.

In the earlier releases, if multiple values are selected in a query filter (operation is "in" or "not in") a 

list control is available. Maximum 3 values can be seen at a time and user doesn't see existing 

selection when they scroll to find more values. From this release onwards, click the ellipsis button 

next to a field to see additional picklist values.

https://help.salesforce.com/htviewhelpdoc?id=working_with_advanced_filter_conditions_in_reports_and_list_views.htm&siteLang=en_US
https://help.salesforce.com/htviewhelpdoc?id=working_with_advanced_filter_conditions_in_reports_and_list_views.htm&siteLang=en_US
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When you click the ellipsis button a pop-up appears.

Add one or many values to the Selected Values area using the right arrow.

Quick Search is a wildcard search which automatically filters down the list of available 

values in the list below.

The values moved to the right under Selected Values area are selected for In or Not in"

operator processing.

Once the user selects a list of values and clicks on Save the window closes and the text on 

the Runtime screen shows the values separated by a comma in the textbox.

Salesforce Method Action

The Salesforce Method action enables you to call Salesforce Apex classes.
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1.  

2.  

3.  

4.  

5.  

6.  

7.  

8.  

To create a Salesforce Method action

Click the lower section of the Actions button and select Salesforce Method.

Under Action Details, type an Action Name for the call procedure action.

Under Salesforce Method Details, select a Class and type a Method.

If the procedure has a return value, select Has return value and select a Return Type object.

If the procedure has parameters, select Has parameters. The Specify Params section is 

enabled.

Type a Param name, and select from the following:

Static: Type a value.

Object: Enables the Object list. Select an object.

Field: Enables the Field list. Select an object field.

User Input: This displays an input field to the user at runtime and passes that input to 

the Salesforce Method.

Click Add Param to add more than one parameter.

Click Save.
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8.  

Save Action

A Save Action pushes Excel workbook data into Salesforce based on a Save Map.

To create a Save Action
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1.  

2.  

3.  

To create a Save action, you must have an existing Save Map.

Click the lower section of the Actions button and select Save.

In Action Name, type a name. If you are just creating one Save Action, you can use Save. If 

you have more than one Save action, then you may need a more descriptive name to 

identify each.

Note

Clicking the  check box will enforce collision detection  Enable Collision Detection
during a Save Action. If another user has modified a field in a record subsequent to 

when that record was retrieved by the current Excel user and the current Excel user 

is trying to update that same field, then X-Author will prevent that record from being 

saved.

Clicking the  check box will allow valid rows to be saved to  Enable Partial Save
Salesforce even if other rows have errors or other issues (for example, rows that 

cannot be saved due to collision detection). Unchecking this box will prevent all 

rows from being saved even if there is a single error.

Click the  check box to highlight the cells or rows that  Highlight Unsaved Records
have an error during a Save Action.
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3.  

4.  

From Save Map, select an existing save map.

Click Save.

Save Attachment Action

A Save Attachment action saves the entire workbook or specific worksheets to the Notes and 

Attachments section of an Individual object. A new attachment is inserted each time this action is 

executed. This action does not provide any file locking. Use a Checkout action if file locking is 

required.

An attachment can be saved either as an Excel or PDF file format.

From May 2016 Patch 2 release onwards, the downloaded attachments have the following 

extensions:

When an attachment is downloaded, the file name is the actual filename in Salesforce. <filename 
.in Salesforce>.<extension in Salesforce>

In case there is a file with the same name and extension, then a sequence number is appended 

after the filename, such as  and <filename in Salesforce> (2).<extension in Salesforce>
.<filename in Salesforce> (3).<extension in Salesforce>

To create a Save Attachment action



X-Author for Excel February 2017 Designer and Runtime Guide

153 Copyright ©2011-2017 Apttus Corporation. All rights reserved.

1.  

2.  

3.  

To create a Save Attachment action, at least one object must be identified as  in Individual
Salesforce objects.

Click the lower section of the Actions button and select Save Attachment.

In Action Name, type a descriptive name for the action.

In File Name, type a file name to be used when the file is executed.

Field Name Description

Use Runtime 

Filename

Select this option to use the existing File Name at runtime.

Manually 

Provide File 

Name

Select this option to allow your user to provide the File Name manually.

Use Cell 

Reference as 

File Name

Select this option to allow your user to use cell reference as File Name. 

Select the cell and click the icon. Note: This feature is not available 
with Presto apps.
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3.  

4.  

5.  

6.  

7.  

From Object, select an individual object.

In Format, select whether to save the attachment as  or .Excel PDF

Leave Custom Sheet Selection blank to save the entire file as an attachment or select the 

check box to save just the worksheets in the Include Sheets box. If you select the Custom 

Sheet Selection check box, you must also select the sheets you want to save from the 

Include Sheets box.

Click Save.

Search and Select Action

This is an interactive way for the end user to search for and select one or more records to retrieve 

from Salesforce. You can have as many consecutive Search and Select actions as required.

To create a Search and Select action



X-Author for Excel February 2017 Designer and Runtime Guide

155 Copyright ©2011-2017 Apttus Corporation. All rights reserved.

1.  

2.  

3.  

4.  

5.  

6.  

To create a Search and Select action

Click the lower section of the Actions button and select Search and Select.

On the Options tab, under Search and Select Action, type an Action Name. Use a 

descriptive name, for example, Search Opportunities.

In Object, select an object. In Searchable Fields, select one or more fields that will be 

displayed to the end user as input fields at runtime.

In the Result Selection, decide whether the user can select a single or multiple results that 

are returned to Excel, and select a Result selection. (You can only select Multiple for a List 

object.)

Single

Multiple

In the Fields to Display in Search Results, select one more fields and use the Sortable field 

to sort the results. In runtime, the user can also sort by any column when the results are 

displayed. You can also reorder the result columns using the Arrows to the right of the grid.

Add filters as required. Please refer to the  for details on Filters section in the Query Action

how to create filters.
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6.  
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6.  

7.  Click Save.

Switch Connection Action

Using the Switch Connection action, you can make your apps automatically disconnect from one 

org and connect to another while executing an action flow. This is very useful if, for example, you 

are migrating data between orgs, or need to download and compare data across orgs without 

requiring a user to manually switch.

When you design your app and add the Switch Connection action to your action flow, your runtime 

users are prompted at the beginning of the action flow to add the connection information.
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1.  

2.  

3.  

4.  

Creating Switch Connection Actions

Switch Connection actions are created through the Actions button on the X-Author Designer ribbon 

menu.

To create a Switch Connection action

In the ribbon menu, click Actions and select Switch Connections. 

 

The Switch Connections Action window opens. 

Type a name in the Action Name field.

This name displays on the X-Author Designer. For example, this is the name you will see 

when you design your action flows.

Type a name in the Switch Connection Name.

This name displays to the runtime user and should be used to prompt the user to enter the 

correct connection information.
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4.  

1.  

2.  

Click Save.

You can now add the Switch Connection action to your action flows.

Using the Switch Connection Action at Runtime

If an app uses the Switch Connection action, the runtime user will be prompted for connection 

information when the app starts. If multiple connection changes are required, the runtime user will 

be prompted for all connection information at one time.

Enter the connection information in the correct order and click Connect for each connection. When 

all connections are completed, click Close.

Executing Actions

An  is a sequential set of Actions that is executed when an end user clicks a Designer Action Flow
configured user menu button in runtime. Each Action in an Action Flow can, and in some cases 

must, take inputs from prior actions and/or provide outputs to subsequent actions.

To create an Action Flow

Click the Action Flow on the X-Author Designer ribbon.

Click Create.
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3.  

4.  

5.  

Enter an Action Flow Name and then click Apply.

Note

Each Action Flow will ultimately be associated with an end user menu command, so 

use a name that clearly represents this flow. When you click Apply, the Action Flow 

in the left pane is updated with the name you enter.

To add a step in the flow, click Add Step.

On the right pane, under Step, type a Step Name (use any name, such as  or 1 Search 
) and then click Apply.Under the Select Action section, select an Action from the list. Account

If this action generates any output, select Persist Data as Output and under Action Output 

section, type a Name for the output. You can use any name (like . If this action requires opps)
an input, select Provide Input, select one from the Action Input list. Based on the type of 

Action, X-Author Designer provides input suggestions. See the table below for more 

information on when to use inputs and outputs.
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5.  

6.  

7.  

8.  

Repeat steps 3 through 5 to add more than one step. Ensure that you click Apply after each 

step and notice the hierarchy updated in the left hand pane.

To reorder a step in the hierarchy, select the step from the left pane and click Step Up to 

move the step up in the hierarchy. Click Step Down to move the step down in the hierarchy.

After you have created the Action Flow, click Save and don't forget to save your application.
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An Action Flow has been created.

Action Flow Check boxes

Field Description

Persist 

Data as 

Output

Select this check box if an action generates any output. Type a for the output. Name 
You can use any name, for example, Opps.

Provide 

Input

Select this check box if an action requires input. Select an action from Action Input 

list. Based on the type of Action, X-Author Designer provides input suggestions.

Suppress 

Save 

Message

Select this check box if you have multiple save actions in a single action flow and 

you want to suppress the save message of that particular action.  This check Note:
box is enabled for Save action only.

Supress Message Validations

When no records found in a Save 
Action check box (App Settings)

Suppress Save Message 
check box (Action Flow)

Behaviour

Yes No Message is not displayed.

No No Message is displayed.

No Yes No Records Found for 
Save message is 

displayed.

Yes Yes Message is not displayed.
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When all records are saved 
successfully in a Save Action (App 
Settings)

Suppress Save Message 
check box (Action Flow)

Behaviour

No No Message for each 

Save action is 

displayed.

No Yes Message is not 

displayed.

Yes No Message is not 

displayed.

Yes Yes Message is not 

displayed.

Action Flow Required Inputs and Outputs

Action Input Output

Check-in Always requires an input because it needs to know on which individual 

record to store the Excel file. Although the individual object is already 

identified when you create the action itself, it is possible you could have 

used that object in different ways in various action flows. Therefore, it 

needs to have the specific output from a prior action as input to this one.

Never

Check-out Always requires an input because it needs to know from which 

individual record to open the Excel file. Although the individual object is 

already identified when you create the action itself, it is possible you 

could have used that object in different ways in various action flows. 

Therefore, it needs to have the specific output from a prior action as 

input to this one.

Never
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1.  

2.  

3.  

Action Input Output

Clear 
Fields

Input is never required. It is tied to a specific Save Map. Never

Display Always requires an input. Any object on a Display Map must be 

represented by an output from a prior Action.

 

Macro Input is never required Never

Query Only if INPUT has been used in the query action filter Always

Dataset Always requires an input. Datasets take the outputs of query action as 

inputs. Output can be saved as a single dataset.

Always

Salesforce 
Method

Input is optional. Optional

Save Input is not required Never

Search 
and Select

Input is reuired only if input has been used in the Search and Select 

action filter

Always

To edit or delete an Action Flow

Highlight an Action Flow on the Action Flow list.

Click Edit or Delete.

To delete an Action Flow that has already been associated with a User Menu button, first 

remove the association in the User Menu.

You can auto execute the action flow and launch an action from Salesforce as well.
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2.  

3.  

To Launch an Action Flow When the App is Opened in Runtime

An Action Flow can be kicked off automatically either when the app is opened directly in Excel or 

from a Salesforce button.

When the App is opened from Excel

Click .Action Flow

Select the  check box for the action flow that should execute Auto Execute (Regular)
automatically

Click Cancel

When the App is opened from a Salesforce button

There are two choices here – either follow the steps above and just click  Auto Execute (Launch 
on the Action Flow to execute when the app opens or you can execute a from Salesforce) 

different Action Flow for each Salesforce button.

For example, if you are creating a quote from an Opportunity, you may want to execute the Create 

Quote Action Flow from the Create Quote button in Salesforce. For the Edit Quote you may want a 

completely different user experience so you would create a second Action Flow and attach that to 

the Edit Quote button.

Creating User Menus

User Menus allow the Designer to create menus that the end user will see in their Excel ribbon 

when they open an X-Author App in runtime. There are two types of menu items:

Configurable menu buttons that will execute the Action Flows

Optional standard buttons that the Designer can use to allow the end user to add rows, 

delete rows, use special paste functions, and have access to embedded X-Author Chatter.

User Menus are divided into two areas:

Groups: These divide the menu buttons into logical areas for the end user. For example, on 

the X-Author Designer menu, the groups are Create, Build, Save, Migrate, and Access.
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2.  

3.  

4.  

5.  

Buttons: These are the menu commands within each menu Group. At least one group and 

one button within that group are required.

Standard Microsoft Excel Ribbon

 

X-Author Ribbon

 

Microsoft Icons
For icons, X-Author uses the standard Microsoft Office icon list, which can be found here:

. Use the procedure below http://www.microsoft.com/en-us/download/details.aspx?id=21103

or any other icon from the list. You must enter the icon capitalization exactly as described in 

the procedure.

To add configurable menu buttons

Click the User Menus button.

From the Add Groups and Buttons section, click Add Group.

Select the  entry in the left pane and from the Properties section, under Default_Group
General, change the Name to the name of the group.

To add a button for the group, select the group from the left pane and click Add Button.

Under the Properties section, do the following:

In Icon, type the name of the Microsoft icon. See the Microsoft Icons.

http://www.microsoft.com/en-us/download/details.aspx?id=21103
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6.  

7.  

8.  

In Name, change the default name to the name of the command.

In Order, type the order that represents the left to right position where this menu 

command should appear in the group.

In Tooltip, type text for a Tooltip.

Select an Action Flow to be executed when the end user clicks on this menu button.

To activate optional standard menu buttons:

To enable the user to add records for any  in the App, select Display Add List Range
Row. You will still need a Save Map for this to have any effect.

To enable the user to delete List Range records from Salesforce, select Display 

Delete Row from Salesforce. You will still need a Save Map for this to have any effect.

Note: Rows are automatically deleted from Salesforce without any further Save or other 

action by the user.

To enable the user to use the X-Author Chatter functionality within this App, select 

Display Chatter.

Click Save.

The user menus are created.

Mapping Records into Columns and Rows

Matrix maps extend the capabilities of X-Author for Excel well beyond the list format. In lists, one 

Salesforce record is represented per Excel row or column. Using matrices, a record can be 

represented by one or more cells by mapping columns and rows (the X and Y axes) of a matrix as 

well as the data contained in the cell at the intersection of the mapped column and row. Depending 

on the design, some matrix cells may be updatable by a user. If no value exists in that cell, adding 

a value can create a new record depending on the matrix design. The following table describes the 

basic elements of Matrix Maps.

Term Definition

Matrix A matrix is any area comprised of one or more "sections."
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Term Definition

Section A section is an area of the matrix that represents a single record. It can include one or 

many row-column-data combinations. Every matrix has at least one section. Each 

section can also have its own section filters.

Column 

mapping

A column mapping is created when you drag a field to the worksheet from a List 

object. The value in the cell can either be a static field label, a static field value, or a 

dynamic field value.

Row 

mapping

A row mapping is created when you drag a field to the worksheet from a List object. 

The value in the cell can either be a static field label, a static field value, or a dynamic 

field value.

Data 

mapping

A data mapping is created when you drag a field to the worksheet from a List object. 

It must be created  the column and row mappings are in place. Each data after
mapping with its column and row mappings must be its own section or must be added 

to an existing section.

Matrix 

filters

Matrix filters are part of the data-getter actions and filter the data as it moves from 

Salesforce into the matrix. Matrix filters can be displayed above the matrix or 

elsewhere in the workbook.

A section is simply any combination of a column and/or a row and the associated data cells, 

either with or without filters, that represents a single record.

A section may also be that same column-and-row-plus-data combination with the addition of 

filters.

There can be an unlimited number of sections in a matrix and an unlimited number of 

matrices in a worksheet.

The data values can be static or dynamic and can be either field names or field values from 

one or more objects.

Filters can be applied to an entire matrix through both the Query action and the Search or 

Select action, or they can be applied separately for each section.
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Empty rows or columns, with or without formulas, can be added.

Data is saved via Save Maps which are associated with Sections, not fields.

Matrix Map Examples

The following examples illustrate some of the capabilities of matrices. The first example uses three 

objects — Budgettrx, GLAccount, and FiscalYear. The objective is to retrieve the Amount field from 

the Budgettrx object for all Marketing Accounts in the GLAccount object and for each Fiscal Period 

in Fiscal Year 14.

Each intersecting cell is one record from the BudgetTrx object.

The data is filtered for the entire matrix to return only Marketing Department data for 

January 2014 – March 2014.

Both the X and Y values are dynamically generated based on “Marketing Department” and 

FY 14 filters.

There is only one section in the matrix comprised of:

Y axis values using the AccountName field values in the GLAccount object.

X axis values using the FiscalPeriod field values from the FiscalYear object.

The XY intersection, which contains the Amount field from the BudgetTrx object.

The second example is a financial plan from a single object where the columns and rows are static 

field values and the intersecting cell is the Amount field in that object.
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8.  
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This matrix has multiple Sections because, even though the column, row, and intersecting cells 

have the same field mappings throughout, the forecast and the actual records differ based on a 

field that is not displayed on the matrix: the Type field. Therefore there are two sections and they 

are distinguished by filtering the data for each section using the section filters.

Creating a Matrix

There is no precise order in which to create a matrix. However, following these steps in order will 

provide better results.

Add your Salesforce Objects.

Decide how you are going to lay out the matrix, including formulas and empty rows and 

columns.

Create your sections and add your empty rows and columns as you go.

If any cells are static, add the cell values at anytime.

Extend or copy your sections to fill out the matrix using the Extend function.

Add Section Filters.

Add Display Filters.

Add Save Maps.

Add actions, action flows, and ribbon menus.

Creating and Extending Sections
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2.  

3.  

Creating and Extending Sections

Creating Sections

This procedure enables you to create a section

To create sections

You must have at least one object selected in Salesforce Objects.

Click Matrix Map.

Click Create.

The Matrix Map pane opens on the right side of Excel.

Type a Name for the Matrix Map.
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b.  

c.  

d.  

If you are creating one Matrix Map, you can use  or any other name. If you are using Map
multiple Matrix Maps, then you need a more descriptive name to identify each one.

Each object and its fields selected in Salesforce objects will be available for use in the Matrix 

Map. Objects are listed based on the object behavior from Salesforce Objects (  and ). Ind List
List fields are displayed by default. You can switch to Individual fields using the Type list.

Create a Row and Column Mapping for each section.

Drag a List field onto the worksheet. When you release the mouse, a pop-up window 

appears.

Click the Row or Column radio button. The Rendering Type, Value Type, and Sort 

options are displayed. All of these work together to determine how row or column 

values are populated.

Select a Rendering Type.

Static: This requires you to enter the cell value manually or X-Author uses the 

Field Label.

Dynamic: Field data is retrieved automatically based on the data getter actions.

Select a Value Type.

If you select the dynamic rendering type, this option is unavailable.

If you select Static from Rendering Type, this option becomes available with the 

following options.
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d.  

e.  

5.  

a.  

b.  

Field Label: Sometimes, the row or column label and the data value will use 

the same field mapping. This occurs when you have multiple fields from the 

same record in the section. This is a placeholder for the Designer to use the 

Field Name as the row or column label. It is the one instance where the 

intersecting value is determined from just the column or row mapping plus the 

data value. For example, if, for a single opportunity, you want to display three 

fields—amount, volume, and average selling price—then, in the rows, the field 

names would be described one on top of the other, and, in the data, you would 

drag the field and the value of that field would be rendered.

Field Value: Enter the value of the field to be used in determining the data 

value. If you look at the previous example, the field value would be either 

Revenue or Cost of Revenue.

Click OK to complete the settings for that field.

Create Data Mappings for each section. Make sure that the cell you are mapping to is an 

intersection of a row and column mapping.

Once you have created column and row mappings, you can drag and drop the field 

that represents the intersection. When you drop the field, the pop up window will 

appear and, in this case, the radio button will automatically default to Data. It uses the 

closest row and column combination.
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Enter a Section Name for the data or select an existing section name from the drop-

down menu.

Select a Row Lookup.

Select a Column Lookup.

Click OK.

Click .Save and Close

Click .Save Application

Extending Sections

Usually, a section will not only be used for a single cell (with its column and row mappings), but will 

be used across a range of cells. To copy the properties of one section to other cells, designers can 

use the Extend Section function (similar to the Excel format paintbrush function).

To extend a section

Click the Sections tab.

Select a section. The cells that comprise that section will be highlighted in the worksheet. 

Make sure your cursor is in the worksheet data cell you want to copy.

Select the remainder of the range to extend to, including the data cell.

Click Extend Section in the pane to the right. The highlighted cells will expand and their cells 

will be mapped on the Fields tab.

The selected section is extended.

Grouping Data in Columns

We have introduced the matrix grouping features which allows you to display data in grouped 

columns within a matrix.

If you want to group pricing data for a region, for a specific devicetype for a particular processor, 

configure the following

Set the Device Type field as a regular Dynamic Matrix Column.

Set the Region field as a Grouped Column on which the data is grouped.



X-Author for Excel February 2017 Designer and Runtime Guide

175 Copyright ©2011-2017 Apttus Corporation. All rights reserved.

3.  

4.  

5.  

Add Processor Name as Matrix Row.

Add Price as a Data Field to the Matrix.

You can add one or more grouped columns on top of the Region Grouped Column field.

  Region (Grouped Column)

Device Type (Column)

Processor Name (Row) Price (Data Field)

In this use case all the fields belong to the same object.While grouping data in columns ensure that 

the fields belong to the same object or are associated with each other via a lookup.

For every Individual Matrix Column of Rendering Type - Dynamic, one or multiple grouped 

columns may exist.

If the same record exists across multiple objects, you can group the data in the cells of a matrix 

based on the objects the data exists in. For Matrix grouping to work, the data has to be structured 

in such a way where the data for a particular field is common. Not every List can be transformed 

into a matrix grouping use-case.

Matrix Grouping is applicable only on columns with Rendering Type as Dynamic. For matrix 

grouping to work, there must be a valid Dynamic matrix column. A user can drag a matrix field on 

top of an already created dynamic Matrix Column. X-Author for Excel automatically detects 

whether a dragged matrix field is a matrix grouped field or not. If it is a grouped field, the Grouped 

Field property is set to true automatically and within the elements of the matrix, the column 

categorized as a Grouped Column.
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To create Grouped Matrices

Click Matrix Map.

Click Create.
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a.  

The Matrix Map pane opens on the right side of Excel.

Type a Name for the Matrix Map.

If you are creating one Matrix Map, you can use  or any other name. If you are using Map
multiple Matrix Maps, then you need a more descriptive name to identify each one.

Each object and its fields selected in Salesforce objects will be available for use in the Matrix 

Map. Objects are listed based on the object behavior from Salesforce Objects ( ). List List
fields are displayed by default.

In an existing Matrix Map if you want to add a grouped column, create a Column Mapping for 

each section.

Drag a List field onto the worksheet. When you release the mouse, a pop-up window 

appears.
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b.  

c.  

d.  

5.  

a.  

b.  

c.  

d.  

Click the Column radio button. The Rendering Type, Value Type, Grouped Field and 

Sort options are displayed. All of these work together to determine how column values 

are grouped.

Ensure that the Grouped Field column is True. If this field is set it to false, the 

column added to the Matrix is not a part of other objects.

Select a Rendering Type.

Dynamic: Field data is retrieved automatically based on the data getter actions.

Click OK to complete the settings for that field.

Create Data Mappings for each section. Make sure that the cell you are mapping to is an 

intersection of a row and column mapping.

Once you have created column and row mappings, you can drag and drop the field 

that represents the intersection. When you drop the field, the pop up window will 

appear and, in this case, the radio button will automatically default to Data. It uses the 

closest row and column combination.

Enter a Section Name for the data or select an existing section name from the drop-

down menu.

Select a Row Lookup.

Select a Column Lookup.Click OK to complete the settings for that field.
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7.  

1.  

2.  

Click .Save and Close

Click .Save Application

Behavior of Grouped Matrices in Runtime

At runtime, the end-user doesn't need to do anything. Based on the matrix grouping design, the 

data will be filtered from top most Grouped Column to last regular Matrix Column and finally the 

data field is rendered.

Saving Matrix Grouping

When a Matrix contains Columns which are Grouped, only update operation can be performed. 

Insert operation cannot be performed.

Matrix Limitations

Currently grouping based on top of matrix columns is supported, grouping for matrix row is 

not supported.

If the data is grouped, you cannot add a row or a column to the matrix.

Creating Records

Depending on the type of matrix you create, a new record may be created when a user enters a 

value in a mapped data cell that was previously blank.

Because of all the possible configuration variations, there is no  rule for record creation, absolute
but there are some guidelines, assuming all required fields are ascertainable from the matrix, 

matrix filters, and section filters.

Records will usually be able to be created when the following criteria are met.

Both the row and column mappings are lookups to other objects from the mapped data 

object.

Column, row, or data mappings are all from the same object, and there are no other fields 

on the matrix.

X-Author will use the following mappings and filters to create a new record:

Section Row

Section Column
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Section Data

Static values identified as  in the Section FilterEqual To

Individual fields used as Matrix Filters

Creating Section Filters

There are two objectives for adding filters to a section.

To filter the data for that section.

To serve as the field value when a record is added in that section.

To add a section filter

To add a section filter, you must have an existing Section.

Click Matrix Map.

Select the desired Matrix Map and click Edit.

Click the Sections tab.

Click the  icon next to a Section to open the filters window.

Add additional rows as needed. Refer to the Query Action section for information on adding 

rows.

Click Save.

Click Save and click Close.

Click Save Application.

Matrix Filters

Matrix data is filtered based on the Query action and the Search or Select action. To display any of 

these filters, the fields must be mapped outside the matrix (usually above the matrix).
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Displaying individual field filters

If you are using an individual field from another object as a filter, then use the Matrix Map Fields 

tab to drag that field onto the worksheet. Matrix Map Individual fields have slightly different 

behavior than Display Map fields because they cannot be updated. They are there for display 

purposes only.

To display a matrix filter

Click the Fields tab.

Select Individual as the Type.

Select a field and drag it onto the worksheet outside the matrix.

Click Save.

Click Save Application.

A matrix filter is displayed.

Working with Mapped Fields

Editing Mapped Fields

The Rendering Type, Field Type, and Sort Value can be changed by clicking the button in the Edit 

column next to the field.

Viewing Sections

To see section layout, highlight a section in the Sections tab and the rows, columns, and data 

mappings that comprise the section will be outlined.

Extending Sections

Usually, a section will not only be used for a single cell (with its column and row mappings), but will 

be used across a range of cells. To copy the properties of one section to other cells, designers can 

use the Extend Section function (similar to the Excel format paintbrush function).

To extend a section
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Click the Sections tab.

Select a section. The cells that comprise that section will be highlighted in the worksheet. 

Make sure your cursor is in the worksheet data cell you want to copy.

Select the remainder of the range to extend to, including the data cell.

Click Extend Section in the pane to the right. The highlighted cells will expand and their cells 

will be mapped on the Fields tab.

The selected section is extended.

Application Settings

The following options are used to affect the runtime user experience, use protected worksheets, 

and secure Excel file saving and printing.
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Disabling the Save and Print Menus

To prevent a runtime user from using the Save, Save As, or Save and Send sub-menus of an 

Excel File menu, click Disable Local Save File.

To prevent a runtime user from using Microsoft Excel's Print menu, click Disable Print.

Disabling Rich Text editing

To prevent a runtime user from adding and editing rich text data, click Disable Rich Text editing. 

Use this option when you want the rich-text field HTML to be populated in the cells rather than the 

editing links that allow the user to add or edit rich text. For more information about rich text editing, 

refer to .Rich Text Fields

Ignoring Picklist Validation on Save

To prevent validation of picklist data during Save Actions. Use this option when you want the 

picklist validation to be ignored when saving the data back to Salesforce in runtime.

Suppressing Messages

Select these options to suppress messages for the specific conditions described.

Field Description

When no records are retrieved 

from a Query Action

Select this check box if you want to suppress the messages 

when no records are retrieved from a Query Action.

When no records are retrieved 

for a parent object from a Query 

Action

Select this check box if you want to suppress the messages 

when no records retrieved for a parent object from a Query 

Action.

When no records are found to 

save in a Save Action

Select this check box if you want to suppress the messages 

when no records are found to save in a Save Action.

https://documentation.apttus.com/display/XAEPOWNOV15/Rich+Text+Fields
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Field Description

When all records are saved 

successfully in a Save Action

Select this check box if you want to suppress the messages 

when all records are saved successfully in a Save Action.

Using Protected Worksheets

All Excel sheet protections work with X-Author for Excel provided the password for each protected 

sheet has been entered. Any worksheets that have been protected will be displayed in the Protect 

Sheet Setting window. Enter the password for each sheet and click .Save

All the options of the protection settings are now supported per sheet. The protection settings are 

remembered (per sheet) even if you unprotect the sheets. The protection settings are reapplied 

when you re-protect the sheets back. X-Author for Excel will not allow the addition of rows or 

columns in a protected sheet.

To protect the sheet

Right-click on the sheet that you want to protect and select Protect Sheet.

Set the permissions by selecting appropriate check boxes.

Enter the password in Password to unprotect sheet text-box.

Click OK.
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Note

You will receive a validation message when you provide a wrong password in App 

Settings in order to protect the sheet. The name of the sheet is also provided with the 

validation message.

Max Attachment Size Limits

Salesforce has a File Size Limit which limits the size of the attachments to be uploaded for a single 

record on Salesforce. For more information regarding attachment limits refer, File Size Attachment 

.Limits in Salesforce

If you increase the file size limits in Salesforce, you can set the file size limit per attachment in a 

record in X-Author for Excel. Navigate to App Settings and set the Max File Size limit. This limit 

indicates the maximum size of an attachment that can be uploaded to Salesforce.

https://help.salesforce.com/apex/HTViewHelpDoc?id=collab_files_size_limits.htm
https://help.salesforce.com/apex/HTViewHelpDoc?id=collab_files_size_limits.htm
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Suppose the records in your application comprise the attachment field and have multiple 

attachments. During insert or upsert, the insert or upsert transaction request is chunked into 

multiple Salesforce transactions so that all the attachments are inserted or upserted successfully.

Color for Unsaved Records

During runtime when a record is not saved due to an error, the following events occur:

For a cell: The cell corresponding to the field in the Save map is highlighted based on the 

selected color.

For a row: The row containing the error record is highlighted based on the selected color.

Set the color you want for the unsaved records or fields in App Settings.

Saving or Cloning an Application

After you have created or edited an application, you save the Application in Salesforce using the 

Save Application menu function.

When you save an application, a series of validations is executed to ensure that required 

components have been included in your App (for example, including an ID field in a repeating 

Display Map where you also have a Save Map). It then saves the changes you have made to the 

Application.

The Save Application button is divided into two parts.

Click the top half of the Save Application button to save the Application. This updates Salesforce.

com with the updated template and configuration.

Always save your Application after you have completed work in any menu function (For example, 

Save Map or Display Map).
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Clicking on the bottom half of the Save Application button to  or  the Application. X-Save As Clone
Author suggests a new name but you can type in a name. This creates a duplicate of the App with 

the new name.

Importing and Exporting an Application

X-Author for Excel Apps can be easily migrated from one Salesforce org to another provided that 

the Salesforce objects being used in the exporting org match those in the importing org.

The Import function imports a previously exported App into the Salesforce org to which you are 

connected.

To import an app

To import a previously exported X-Author for Excel .app file follow the steps below:

Click Import.

To browse for the Application to import, click Browse App.

From the X-Author Application Import dialog, select the file with an  extension and click .app
Open.

Under App Details, in Import App Name, change the name of the App, if required, and click 

Import.
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The App is imported into your current Salesforce org.

Best Practice

To avoid errors using the app in the new org, make sure to  the app after the Validate
import is complete. This will identify any existing mismatches in objects and fields defined 

in the app. If you do encounter errors upon validation, check the objects and fields 

affected, make changes to your app or in your org as needed, and perform the import 

process again.

To export an app

Click Export.

Choose a location and enter File Name.

Click Save.
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An app file with .app extension is saved at the chosen location. The Export function saves an App 

as an .app file. This file can then be used by the Import function to add that App to a different 

Salesforce org. You should also use this function to back up your apps while creating them.

Migrating Applications

Migrating data requires the following functions:

Source Data provides a mapping mechanism for helping to migrate data between 

Salesforce orgs.

It is combined with the Paste from Mapping menu option in runtime or Paste Source Data 

action function to copy data from an entire workbook to another workbook in the desired 

format.

The most common use case for this is for migrating data from one Salesforce org to another far 

more easily and quickly than can be done with the traditional single object data loading tools. The 

source App is for downloading all the data you need to migrate. Each object can be represented in 

one worksheet for example. The target app is a replica of the source app except it is for uploading 

data to the target org. The Source Data function provides the mapping between the Apps.

You could also choose to create a more advanced single app that handles both the source 

download and target upload. For this you would need to make use of both the Switch Connection 

and Clear Actions as well.

To use Source Data to migrate data

Open the source App in X-Author Designer and make a note of the starting cell location for 

each range of data that needs to be copied.

Click File > Save As and save the file to your local drive. Use any file name.

Open the target App in X-Author Designer and click Source Data on the menu.

Select Source Excel Sheet, locate the file above and click Open.
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Use the drop down arrow under Source Sheet to select a worksheet.

In the Source Range enter in the starting range cell location for that worksheet.

Use the drop down arrow under Target Sheet to select a worksheet.

In the Target Range enter in the starting range cell location for that worksheet.

Repeat these steps for each of the other worksheets.

The starting cell in the Target Range must be one row below where you have your fields mapped. 

So if you have all fields mapped in A3:J3 for example, the Target Range would be A4.

The Paste from mapping function in runtime will copy all data in the list range from the source 

based on the source range starting location. For example, if you have a data range from A3:J3, it 

will copy all cells in that range into the target App.

Using the Data Migration Wizard

X-Author for Excel provides a built-in solution for migrating data from one Salesforce org to another 

with the  wizard. Using the Wizard, you can choose Objects, Fields including Data Migration
related Lookups to build an app configured to retrieve data from the connected source org and 

save data to a target org. The wizard takes care of all display maps, save maps, actions flows and 

user menus so you have an app ready to use when you are done. As a designer, you can also 

customize the app after completing the wizard steps to tailor it to your requirements.

Certain restrictions apply to app design after you have completed the Data Migration 

wizard. Consult the following sections for a list of restrictions.

To start building a new Data Migration app using the Wizard

Go to the X-Author for Excel Designer tab and Connect to the  Salesforce org.source

From the X-Author for Excel Designer ribbon, click on the arrow next to .Data Migration
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Click to open the Data Migration Dashboard.New 

Enter an  for your Data Migration app.App Name

Adding Objects and Fields to your Data Migration App

To begin building your Data Migration app, you need to configure which Objects and Fields should 

be part of the migration. If you are working with an existing Data Migration app, you can make 

changes to the Objects and Fields already present in the app (with some restrictions–see Making 

).Changes to Your Data Migration App
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When you create a new Data Migration app or edit an existing one, the following screen is 

displayed.

To Add Objects to your App

From the upper right-hand corner of the screen, click on .Add Objects
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Double-click on an Object or highlight and Object and use the arrow button to add Objects to 

your app. To refine the list of Available values, click on .Search

Click to add the selected Objects to your app. The Data Migration Dashboard updates Save 
with an entry for each Object you added.
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Note

Do not worry about the sequence of Objects in your app at this time. Sequence will adjust 

depending on how External ID and Lookups are set.

To Add Fields to your App

After at least one Object has been added to your Data Migration app, you can add fields for each 

selected Object.

From the Data Migration Wizard screen, click on the link under the  column Fields
corresponding to the Object you want to work with.
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Select the check box for each field you want to add to your app. To refine the list of fields, 

enter text into the field. Note: You cannot deselect the Object fields ID or Name.Search 

Click  to add fields to your app for the selected Object.Apply

Repeat steps 1 – 3 for each Object in your app, as required.

If Fields for one of the Objects in your app have been previously added, you can click the 

hyperlink under the "Fields" column to add or remove more Fields.

Working with the Data Migration Dashboard

After adding Objects and Fields to your app, you can take the following actions as needed:

Specify a unique  for each Object in the app.Display Name

Click on the link under the  column to add or remove more Fields for an Object.Fields
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Click on the link under the  column to add or remove more Lookup Fields for Lookup Fields
an Object.

Click on the  icon to copy an Object listing and modify it as required (for example, Copy 
you want to add the same Object and a different set of Fields for filtering purposes). Note: 

The Copy action will not copy any defined filters.

Click on the   icon to remove an Object from your app.Remove

Specify , , and . Refer to Load Sequence Actions Filters Configuring your Data Migration 

 for step-by-step instructions for these tasks.App

Adding Lookups to your Data Migration App

In addition to Objects and their Fields, you can also add Lookup fields that reference other Objects. 

Adding Lookup fields allows you to include fields from certain Objects that have a Lookup 

relationship to the Object you are migrating (e.g., AccountId for Opportunity). The Lookup Object 

can only be referenced if it has been included in the fields for that Object in Salesforce. Also, fields 

already added to your app will not be visible in the Lookup dialog.

To add Lookup Fields to your App

From the Data Migration screen, click on Add Lookups.
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1.  

2.  

3.  

4.  

Navigate the Object/Field tree and select one or more check boxes to add lookup fields to 

your app. Fields that have already been added to your app are not displayed.

Click to add all selected Lookup fields to your app.Add 

Click . The Lookup fields are added to all related Objects in the app. When Lookup fields OK
are added:

Each affected Object displays the number of Lookup fields that will be migrated when 

the app is run.

Fields representing the Lookup fields are added to the Object under the "Fields" 

column.

You can click on the link under the "Lookups" column to view all Lookup fields added 

for a specific Object.

The Object sequence is automatically adjusted based on Lookup relationship 

between Objects (the sequence for dependent Objects are changed).
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4.  

A filter (see below) is automatically created for the Object. Do not remove this filter 
unless you are planning to remove the Lookup field entirely.

Removing Lookups

To remove any lookup field from an object, first delete the filter (pictured above). Next, 

click on the link under the "Fields" column, deselect the lookup field in the list, and click 

.Apply

Configuring your Data Migration App

Before your Data Migration App can be finalized and ready to use, you need to specify load 

behavior, actions and filters for data retrieval.

Determining Load Sequence

By default, Salesforce Objects retrieved from the source org will load in the sequence listed on the 

Data Migration screen. If you want to change the load sequence behavior, you need to specify a 

new load sequence for Objects in the list.
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To accomplish this, edit the  column for your objects. Use caution when making Load Sequence
changes, as load sequence is important when migrating data. Users will encounter errors from 

Salesforce, for example, if a Child Object load sequence is specified prior to its Parent Object. 

Also, you cannot finalize the app if there is a number missing in the load sequence or two or more 

Objects share the same Load Sequence.

Choose a User Action for each Object

Each Object in the Data Migration must have a corresponding action in the runtime app. This 

allows the user to make use of X-Author's Search & Select or Query actions to request data from 

the source org during the migration.

To choose actions, click the drop-down menu next to each Object and select either Search & 
or Select Query:

Search & Select actions provide an interactive way for users to search and select one or 

more records from Salesforce that match pre-defined filters for the action.

Query Actions automatically retrieve information from Salesforce based on pre-defined 

filters and/or user input. If user input is required, the user chooses values based on the 

Query filter. In certain action flows, Query actions will be dependent on input specified by 

the user during Search & Select.

For example, you might configure a Search & Select action for Account that allows the user 

to specify certain Account records to be migrated. You can then configure a Query action to 

allow the user to return only Opportunities for the Accounts chosen in Search & Select and 

only those Opportunities with a specified Owner.

For both and  actions, the Options are automatically filled based on the Search & Select Query
Objects and Fields you added to your app. You can make changes to these options as required 

when you define .Filters
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1.  

2.  

a.  

b.  

c.  

3.  

For more information on these actions, refer to  and  actions in this Search & Select Query

guide

Filtering Search & Select and Query Actions

To refine the data selected for migration when the user goes through the Data Migration app 

Action Flow, you can specify one or more filters for each Object being migrated. The process for 

defining filters is the same for each action type.

To define Filters for an action:

Click on the   icon next to the corresponding action.Filter

Define one or more filters to apply to data retrieved for the selected Object and its Fields:

Use the Expression builder to specify a , , and  for your Value Type Operator Value
filter.

Click  to create an additional filter.Add Row

Click  to specify additional logic for the filters you create.Add Filter Logic

Click  when you are finished defining Object and Field filters.Save
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When you configure an Object to have a lookup field (e.g., Opportunity to Account), a 

filter of value type "Input" is automatically created to demonstrate the relationship. Do not 

delete this filter unless you intend to delete the lookup field entirely. You can use this filter 

to specify the lookup field as the value when you want to constrain migration data 

according to user selection for the lookup object.

When building filters, you can only create expressions for Objects and/or Fields already 

added to the app.

For complete instructions on building S&S and Query filters, refer to .Query Action

Specify External ID

This is an optional step that is only required if your Object has more than one Salesforce External 

ID. Most Objects will only have a single External ID, but in some cases an Object will have more 

than one (for example, you export data for this object to more than one external source). Setting 

the External ID is important to prevent duplication of records during data migration.

Note

All Objects must have a set External ID. If an Object does not have an External ID set, 
. It is recommended to configure External ID's in you will not be able to save the app

Salesforce for every Object that you want to migrate before creating the Data Migration 

app. You can configure External ID's for your Objects in one of two ways:

Use Apttus' Metadata utility to create External IDs for each Object you want to 

migrate. Contact your Apttus representative to get access.

Configure External ID's for your Objects using Salesforce. Create a text field 

labeled , field name  per configuration in the image APTS Ext ID APTS_Ext_ID
below. Refer to Salesforce administrator documentation for help on how to add 

fields to your Objects.



X-Author for Excel February 2017 Designer and Runtime Guide

202 Copyright ©2011-2017 Apttus Corporation. All rights reserved.

1.  

2.  

You will need to restart X-Author after adding the External IDs.

When an Object has more than one External ID, a  link will be visible under the "External Not Set

ID" column.

To specify External ID for an Object

From the Data Migration screen, click  under the "External ID" column corresponding Not Set
to the Object you want to set.
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2.  

3.  

1.  

Using your cursor, highlight the correct External ID ( ) field to use for your APTS_Ext_ID
Object.

Click . The chosen External ID is updated in the Data Migration Object listing.Apply

Configuring Data Migration App Settings

You can specify settings for your Data Migration app to customize the Action Flow and User 

Menus.

To configure settings for your Data Migration App

From the Data Migration screen, click on .Settings
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1.  

2.  

3.  

Specify values for your app settings. Refer to the table below for a list of settings and their 

descriptions.

Setting Description Guidance

Export 

All Suffix

Enter custom text to replace "All" 

for the "Export All" button of the 

app.

Limit the suffix to fit text in the X-Author 

ribbon.

Export 

Selective 

Suffix

Enter custom text to replace 

"Selective" for the "Export 

Selective" button of the app.

Limit the suffix to fit text in the X-Author 

ribbon. Suffix should represent filters 

defined for your Objects.

Click  to apply your settings.OK
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Finalizing your Data Migration App

When you are finished creating your Data Migration App, return to the Data Migration screen and 

click  (or  if you are editing). The Wizard creates or updates the app based Create App Update App
on your specifications and displays the resulting app as shown in the example below.

When you create or update a Data Migration app it is automatically saved once you click 

Create App/Update App. Please remember that if you make any additional changes to the 

app, you must save the app in X-Author.
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Making Changes to your Data Migration App

Since the Data Migration app is an X-Author app, created using the Wizard instead of the 

individual designer tools, most elements of the app can still be modified by the designer before the 

app is finalized. Click on any of the buttons in the Designer tab to see the Display Maps, Save 

Maps, Actions and User Menus created by the Data Migration Wizard.

Be especially careful when modifying a Data Migration app after you create it with the 

Wizard. Because the app is assembled using the Wizard, you may inadvertently break the 

functionality if you modify maps or remove other components. If you want to add or 

modify any Objects or Fields, it is recommended to  the app using the Data Migration Edit
Wizard (see below), rather than editing Display/Save Maps and other elements of the app 

directly.

Add Custom Actions or User Menus to your app as required to finalize your Data Migration App.

Editing your Data Migration App Using the Wizard

When you want to modify a Data Migration App to add, remove or change Objects, Fields, 

Lookups, or change Filters and other settings, go to the Data Migration Wizard and select .Edit

If the changes you want to make to the Data Migration App are significant enough, it is 

recommended to create a new app rather than modify an existing one.

Please note that you cannot change the following components of an app when you are editing it:
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1.  

2.  

3.  

App Name

User Actions

External ID

If you want to make changes to any of the above, you can still remove an Object from the app and 

add it back again, making any changes as required.

Performing the Data Migration

This page provides instructions for performing a Data Migration from one Salesforce org to another 

using an app created with the . Instructions may vary slightly depending on if Data Migration Wizard

any customizations were made to the app outside of the Wizard. For help with specific user actions 

or action flows, refer to the appropriate section in this guide.

Prerequisites

The app to be activated for use by the user doing the migration.

The user must also have access to the X-Author for Excel Designer tab.

To perform a data migration

From the X-Author Designer tab, export the app to your computer and Import the app to the 

Salesforce org where your source data resides. Follow the instructions under Importing and 

, then move to the next step on this page.Exporting an Application

Import Best Practice

 To avoid errors using the app in the new org, make sure to Validate the app after 

the import is complete. This will identify any existing mismatches in objects and 

fields defined in the app. If you do encounter errors upon validation, check the 

objects and fields affected, make changes to your app or in your org as needed, 

and perform the import process again.

Click on the  tab to switch to the runtime view.X-Author for Excel

Select to open the app.App > (your Data Migration App Name) 
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3.  

4.  Populate the app by choosing one of two options (Note: the name of these actions may be 

different, depending on app ):settings

Export Selective - Choose this action if you want to search for and select specific 

records to export from the source org for each Object in the data migration app. After 

making your selections, click  to retrieve data into the app.Next

Use this option when there are Filter criteria defined for any of the Objects 

in the app. User actions defined for Objects in the app (like Search & 

Select) only execute when this option is chosen.
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4.  

5.  

6.  

Export All - Choose this action if you want to export ALL records from the source org 

for each Object in the data migration app. No filters are applied.

Note

This option may take an unusually long amount of time to retrieve data if 

there are a large number of records in your Org.

From the Source Org section of the X-Author Excel tab, click .Save Source Data

Browse to a location on your system to save the workbook. Name the file and click . All Save
data retrieved by the Export action is saved to the app.
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6.  

7.  

8.  

9.  

10.  

11.  

12.  

13.  

Close the app.

From the X-Author Designer tab, click on  and select the target org for Switch Connection
data migration. Enter your credentials and connect.

You must now import the Data Migration app you exported in Step 1 into the target org. 

Select  and browse to the app file.Migrate > Import

Click . Verify the app imported successfully and click .Import OK

Click on the  tab to switch to the runtime view.X-Author for Excel

Connect to the target org.
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13.  

14.  

15.  

16.  

Click on  and open the imported app.Apps > Open App

From the Edit section, click on Paste and select .Paste from Mapping

Browse to the app file save in Step 5 (saved source data) and click .Open

Note

Source data that you exported is pasted into the app without . Target Record ID
Record IDs will be assigned to all new records that are created when you migrate 

that data to the Target Org (but will not be represented in the app).

From the Target Org section of the ribbon, click . The exported records from the Save All
source org are migrated to the target org. Depending on how much data you are migrating, 

this can take some time. When data migration is complete, a separate success message is 

shown for each Object being migrated. Click on  to view details.Show details
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16.  

Note

The success message may not be shown if settings have been changed in X-

Author Excel to suppress messages. Refer to  for more Application Settings

information.

Updating Records during Migration

As part of the migration, you may choose to update (or upsert) existing records in the target org 

with updated data from the source org. In this case, you are updating or upserting data from the 

source org records to target org records. You do this by modifying the exported data from the 

source org prior to migration. You can also update/upsert records following the initial migration by 

reusing source data in a subsequent migration. The following use case shows an example of this.

Use Case: Updating Records after Migration

Diana Designer has performed an initial migration of data from a source production org to 

a target production org. After the migration, she decides that she would like to perform 

some updates to some Opportunities in the migration. Diana can use X-Author 

functionality to update (or upsert) records by modifying the same source data she used 

during the initial migration.
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1.  

2.  

3.  

4.  

She performs the following steps to update the migration data:

Diana connects to the  and reopens the Data Migration app in Target Org X-Author 
.for Excel Runtime

She selects . Diana browses to the source data Edit > Paste from Mapping
workbook from the previous migration and opens it in the app. The  Account
worksheet is displayed.

Diana choose to update some Account phone numbers.

She then moves to the Opportunity worksheet.
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4.  

5.  

6.  

Diana modifies some Opportunity amounts.

Diana selects . She has successfully upserted the migrated Target Org > Save All
records.

Note

You can also add rows using the method to Insert new records. Because the workbook is 

protected, you must copy an existing row, use the "Paste Values Only" action from the X-

Author ribbon and make changes (remember to remove the Target Record ID if one is 

displayed).
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1.  

Creating External Actions

Over and above the standard actions, Designers can now include their own actions through the 

External Library capabilities. This requires the use of the X-Author SDK libraries to create custom 

dlls. For example, you could create an external action for something as simple as record data 

cleansing, or something more complex such as invoking Oracle or SAP web services.

Prerequisites for creating Actions

An Integrated Development Environment that enables you to build dlls. In the example in 

this procedure, Microsoft Visual Studio is used to describe the setup process for External 

Actions.

How to design an External Action

Create a Visual Studio Class Library Project. The X-Author client installer includes a sample 

C# file.

The code sample shows the functions to use and it will pop up a message box in runtime. 

You can extend the  function to write your custom logic using the full power of Execute()
Visual Studio and .NET.
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1.  

2.  

3.  

4.  

Add a reference of the Apttus.XAuthor.ExtensionLib module into the project. The Apttus.

XAuthor.ExtensionLib action class which represents an action is available for external use in 

this SDK Library. Any user who designs a new action, needs to add a reference of this 

library in their Visual Studio project. This library extends the following:

Action Class extends the capabilities of the Base class capabilities to the custom  .cs
file.

IActionRuntime interface invokes the execute method defined in a custom .  file.cs

Provide  and  for the external action and provide custom logic for the  Name Type Execute()
function.

Compile and link the assembly to generate the output .NET assembly. The .NET assembly 

should be a .dll file. 

using System;
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4.  

using System.Collections.Generic;
using System.Linq;
using System.Text;
using System.Threading.Tasks;
using Apttus.XAuthor.Core;
using System.Xml.Serialization;
using System.Runtime.InteropServices;
namespace TestExternalAction
 
//Apttus.XAuthor.Core.Action is the base class of the module 
for which the capabilities are extended. Using the 
IActionRuntime interface invokes the custom execute method. 
{
    public class FirstExternalAction : Apttus.XAuthor.Core.
Action, IActionRuntime
    {
        //Custom class. You can define any object that you 
choose in your class. 
        public FirstExternalAction()
        {
            Name = "First External Action";
            Type = "External Message Action";
        }
        //Defining the logic on execution of the external 
action. 
        public ActionResponse Execute(ActionRequest request)
        {
            ActionResponse r = new ActionResponse();
            System.Windows.Forms.MessageBox.Show("External 
Action : Executed");
            r.Status = ActionResultStatus.Success;
            return r;
        }
 
    }    
}

The sample *.cs file can contain one or more external actions.

How to link an External Library into X-Author
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1.  

2.  

3.  

How to link an External Library into X-Author

After developing an External Action that is part of a library (.NET assembly), load the library into X-

Author Designer using the following steps.

Navigate to the X-Author for Designer Tab.

Click External Library, load the required  file and click OK. .dll

After you load the selected assembly, X-Author detects all the external actions within that 

assembly.

Invoke the newly created external actions within an Action Flow just like built-in actions.

To update an existing external library

To update and link a new version of the library into X-Author, ensure that any external actions 

within that library are not in use in any Action Flow. You can update an existing external library 

only under certain conditions.

How to remove an existing external library

A user can remove an already linked external library. To remove an existing library, open the 

existing library and select a row and click Unlink Library. An External Library can only be removed 

if any of the External Actions exported in the library is not used in an Action Flow.

Uploading or Downloading File Attachments

You can upload and download file attachments using X-Author for Excel. For example, if you 

create an app that uses Salesforce objects that contain attachments, such as the Opportunity 

object, you can now download opportunity-related attachments from Salesforce and upload 

attachments to Salesforce. All you need to do is add the attachments field to the Salesforce 

Objects, the Display Map, and–if you are uploading attachments–the Save Map.

Downloaded files are located in , %AppData%\Local\Temp\X-Author Attachments\[Object_ID]\
where %AppData% is the location of the logged-in user's AppData directory in Windows (for 

example, C:\Users\bdwyer\AppData) and Object_ID is a mashup of the name and the ID of the 
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object the attachment is associated with, such as an Opportunity. You can upload files from 

anywhere on your workstation, though. To upload a file, you need to provide the full path to the 

document and the document name as shown in the following example. If you are uploading 

multiple attachments, separate them with a pipe ( | ) as shown in the following example.

In this example, the files will be uploaded to the opportunity when you save the data to Salesforce.

Example: Opportunities by Account App

App Objectives

The end user will search for and select an Account from Salesforce.

Based on the account selected, the app will automatically retrieve all Opportunities into 

Excel.

For the Account, the app will include the Name and Phone fields.

For each Opportunity the app will include the Name, Amount, Close Date, and Stage fields., 

Allow the end user to save modifications to just the Amount and Stage fields for each 

Opportunity.

App Components

You will use the following app components to build your new app.

Component Component Description

Salesforce Objects Account (Individual) and Opportunity (List)

Display Map Individual and List fields per objectives

http://documentation.apttus.com/display/XAEPOWNOV15/Salesforce+Objects
http://documentation.apttus.com/display/XAEPOWNOV15/Display+Maps
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1.  

2.  

3.  

4.  

5.  

1.  

2.  

3.  

4.  

5.  

6.  

Save Map Using fields from the Display Map

Actions Search and Select Action for the Account

Query Action to retrieve the Opportunities for the Account

Display Action to transfer the retrieved data to the Display Map

Save Action to save back to Salesforce any user modifications

Action Flows One to retrieve the data and display it and one to save it

User Menus One button for the user to retrieve opportunities and one to save them

To create the Opportunities by Account App

In the ribbon menu, click Apps and select New Application. 

In the App Name Field, type Opportunities by Account.

In the Select Template section,click the New radio button. 

Click Create.

For the app type, select the product edition. For example, Enterprise.

To select Salesforce Objects

Click Salesforce Objects and locate Account > Opportunity and then click Add Child Object.

In the right-hand window, click Account (Ind).

Select fields from Add Fields below area: Region, Name and Phone.

Click Apply. Note: You must click Apply after you have selected the fields for any object.

In the right-hand window, click Opportunity (List).

http://documentation.apttus.com/display/XAEPOWNOV15/Save+Maps
http://documentation.apttus.com/display/XAEPOWNOV15/Actions
http://documentation.apttus.com/display/XAEPOWNOV15/Action+Flows
http://documentation.apttus.com/display/XAEPOWNOV15/User+Menus
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6.  

7.  

8.  

9.  

1.  

2.  

3.  

4.  

5.  

6.  

7.  

8.  

9.  

1.  

2.  

3.  

4.  

5.  

Select fields from Add Fields below area: Account Id (automatically selected for you because 

this is the lookup field to the parent object in the object hierarchy), Amount, Close Date, 

Name, and Stage.

Click Apply.

Click Save and Close.

Save the Application.

To create a Display Map

Select Display Maps and click Create.

In the Name field, type Main and from the Type list, select Individual.

Drag Account Name to C3 and Phone to C4. You will see the link between the cell and field 

stamped in the bottom right-hand window.

Switch to List.

Drag Name to B7, Amount to C7, Close Date to D7, Stage to F7, and Id to H7. Now click on 

the orange account id field (with a + next to it) and it will take you to the Account object. 

Select the Region field from there and drag it to G7. X-Author allows you to have fields from 

any related object on the same list row.

Select Options and change the Sort by picklist to Name.

Save the Display Map and click Close.

Add a title to B1: .Opportunities by Account

Save the Display map.

To create a Save Map

Select Save Map and then click Create.

In the Name field, type Main.

Click Add Display Map Field and select Amount and Stage.

Click Apply and then click Save.

Save the Application.
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1.  

2.  

3.  

4.  

5.  

6.  

7.  

1.  

2.  

3.  

4.  

5.  

1.  

2.  

To create a Search and Select Action

In the main ribbon under Actions, click the arrow and select Search and Select.

In the Action Name field, type Select Account

From the Salesforce Objects list, choose Account

In the Search window, click the check box next to Name.

In the Name in Fields to Display in Search Results, click the check box next to it and the Sort 

check box to the right.

From the Results area, choose Single.

Click Save.

To create a Query Action

Click the arrow under Actions on the X-Author for Excel ribbon and select Query.

In the Action Name field, type Query Opportunities.

From the Object list, choose Account.Opportunity

In the Filters section, click the lookup icon and select the account id field to restrict the 

Opportunity records to those that match the Account that was selected by the user. Because 

this is a lookup field, click just to the right of the orange field to select the row and click 

Apply. Select the other parameters based on the table below.

Salesforce Object 
and Field

Value 
Type

Operator Value

Account ID Input Equals Account Id from the Accounts object will 

default. (i.e. Account.AccountID)

Click Save.

To create a Display Action

Click the arrow under Actions and select Display.
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2.  

3.  

4.  

1.  

2.  

3.  

1.  

2.  

3.  

4.  

5.  

6.  

7.  

8.  

9.  

For the Action Name, type Display Opportunities.

From the Display Map list, choose Main.

Click Save.

When data has been retrieved from Salesforce, it is placed in Excel memory, waiting to 

be placed into the specific worksheet based on a Display Map. You may want to display 

different maps at different times when your App is in use, so a Display Action lets you 

decide which map to use and when to use it

To create a Save Action

Click the arrow under Actions and select Save.

In the Action Name field, type Save Opportunities.

From the Save Map list, select Main.

Now that you have created your actions, you need to create Action Flows to retrieve and display 

data and to save data.

To create a flow to retrieve and display Opportunities

Click Action Flow and then click Create.

Enter Retrieve Opportunities into the Action Flow Name field and click Apply. The left-hand 

window is updated.

Click Add Step.

In the Step Name field, type Select Account  From the Action list, select Select Account..

Select the check box next to the Persist Data as Output check box and enter Account in the 

Action Output field.

Click Apply and then click Add Step.

In the Step Name field, type Query Opportunities.

From the Action list, select Query Opportunities.
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Select the check box next to Persist Data as Output and enter Opps in the Action Output 

field.

Select the check box next to Provide Input and then select Account from the picklist.

Click Apply and then click Add Step.

In the Step Name field enter Display Opportunities and select Display Opportunities from the 

Action list.

Select the check box next to Provide Input and select Account and Opps from the Action 

Input list.

Click Apply and then click Save.

To create a flow to save Opportunities

Click Action Flow and then click Create.

In the Action Name field type  and then click Apply.Save Opportunities

Click Add Step and from the Action list choose Save Opportunities.

Into the Step Name field, enter  and click Apply.Save Opportunities

Click Save.

Save the Application.

The  is to .final step add the end-user menus

The workflow to add end-user menus is as follows:

You first add a  and highlight the group to add buttons underneath it.Group

For each group or button, you can change the names of each by overwriting the 

 or  in the right window.Default Group Display Item

When you add a button,  is the order in which the buttons will appear on the end Order
user menu.

Action Flow is for associating a menu item to the Action Flow that will be executed by 

the end user.
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For icons, X-Author uses the standard Microsoft Office icon list which can be found 

here: . Use what is http://www.microsoft.com/en-us/download/details.aspx?id=21103

provided in the procedure below or any other icon from the list. You must enter the 

icon capitalization exactly as it is described in the procedure below.

The steps to add end-user menus are described in detail in the following sections.

To create User Menus

Click User Menus.

Click Add Group.

In the Name field Enter Opportunities and  in the Order field.1

Click Add Button and in the Name field enter Retrieve Opportunities .

In the Icon field enter GetExternalDataFromOtherSources .

Enter  in the Order field.1

From the Action Flow list, select Retrieve Opportunities.

Click on Opportunities to highlight the group and then click Add Button.

In the Name field enter Save Opportunities.

In the Icon field enter SaveObjectAs .

In the Order field enter .2

From the Action Flow list, select Save Opportunities.

Click Save

Save the Application.

Making the end-user menus look good

Enlarge the title.

Highlight the row headings.

Identify to the end user the columns or cells that are modifiable by highlighting them in a 

different color.

http://www.microsoft.com/en-us/download/details.aspx?id=21103
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You can delete the text in brackets. This does not remove the fields because those are in the 

map. This just makes the presentation more pleasing.

Make sure to place your cursor in the cell and use the Delete key. Do not use row delete!

After you follow all the procedures in this section, a new App with the name Opportunities by 

Account has been created.

Example: Opportunity Forecast Application

App Objectives

The end user invokes all opportunities, for which they are an owner, from Salesforce into 

Excel.

For each Opportunity include: Name, Amount, Close Date, Stage, and Owner . Id

Allow the end user to save modifications to only the Amount and Stage for each Opportunity.

App Components

You will use the following app components to build your new app.

Component Component Description

Adding Salesforce Objects to 

your App

Opportunity (List)

Display Map Opportunity Fields as above

Save Map Using fields from the Display Map

Customizing the App 

Experience

Execute Query Action with a restriction on "Owner ID"

Display Action to transfer the retrieved  data Opportunity
to the Display Map

Save Action to save back to Salesforce any user 

modifications
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Component Component Description

Executing Actions One to retrieve opportunities and one to save them

Creating User Menus One button for the user to retrieve opportunities and one to save 

them

Creating the Opportunity Forecast Application

Application creation is a multi-step process, starting with naming the app and ending with the 

creation of your end-user menus. The steps are:

Create the new App.

Select Salesforce Objects to use in the app.

Create a Display and Save Maps.

Create Query, Display, and Save actions.

Create and Action Flow.

Create end-user menus.

The steps are described in detail in the following sections. You will complete each step as you 

build your Opportunity Forecast app.

Prequisites

You must be connected (through the X-Author Designer) to a Salesforce org that is 

enabled for X-Author for Excel.

To create the Opportunity Forecast App

In the ribbon menu, click Apps and select New Application.

In the App Name Field, type  and in the Select Template section, click Opportunity Forecast
the New radio button.
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Click Create.

Select edition. For example, Enterprise.

To select Salesforce Objects

In the ribbon menu, click Salesforce Objects.

In the Objects list, locate Opportunity either by scrolling or by typing in the first letter to jump 

to the nearest match and then scrolling.

Click Add Parent Object. This will always be true if you have just one object. The object is 

now in the selected box on the right and is automatically assigned default  behavior.List

In Add Fields below, select the following field names: Account ID, Amount, Close Date, 

Name, Owner ID, and Stage.

Click Apply.

Note: You must click Apply after you have selected the fields for any object or these will not 

be saved if you have more than one object.

Click Save and Close.

Click the Save Application button.

To create a Display Map

Click Display Map and select Create.

In the Name field, type  and from the Type drop-down, select List.Main

Drag Account Name to A7. This was not an available field in Salesforce Objects but X-

Author for Excel always brings in the Name field for any lookup field selected in Salesforce 

Objects.

Drag Name to B7, Amount to C7, Close Date to D7, Stage to F7, Opportunity Id to H7.

Click Options and change the Sort by list to Account Name.

To save the Display Map, click Save and then click Close.

Add a title in A1, for example, Opportunities Forecast.

Save the Application.

To create a Save Map
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To create a Save Map

Click Save Maps and select Create.

In the Name field, enter  into the Name field.Main

Click Add Display Map Fields and select Amount and Stage.

Click Apply and then click Close for the Save Map.

Click the Save Application button.

To create a Search and Select Action

Click the arrow under Actions on the menu and select Search and Select.

Enter  into the Action Name field.Select Account

Choose Account from the Salesforce Objects list.

Click the check box next to Name in the Search window.

Click the check box next to Name in Fields to Display in Search Results and the Sort check 

box to the right.

Choose Single from the Results area.

Click Save.

To create a Query Action

Under Actions, click the arrow and select Query.

In the Action Name field, type Query Opportunities and from the Object picklist select 

Opportunity.

In the Filters section, select or enter the following to restrict the Opportunity records to those 

for which the current user is the  owner. Click the lookup icon  and select the Opportunity
owner idOK field. Because this is a lookup field, click just to the right of the orange field to 

select the row and click Apply. Select the other parameters based on the table below.
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Salesforce Object and Field Value Type Operator Value List

Owner Id SystemVariables Equals CurrentUser

Click Save.

To create a Display Action

Click the arrow under Actions and select Display.

Enter Display Opportunities into the Action Name field.

Choose Main from the Display Map list.

When data has been retrieved from Salesforce, it is placed in Excel memory, waiting to 

be placed into the specific worksheet based on a Display Map. You may want to display 

different maps at different times when your App is in use, so a Display Action lets you 

decide which map to use and when to use it.

To create a Save Action

Click the arrow under Actions and select Save.

Enter Save Opportunities into the Action Name field.

Select Main from the Save Map list.

Click Save.

Save the Application.

Now that you have created your actions, you need to create Action Flows to retrieve and display 

data and to save data.
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To create a flow to retrieve and display Opportunities

Click Action Flow and then click Create.

In the Action Flow Name field, type Retrieve Opportunities and click Apply. The left-hand 

window is updated.

Click Add Step.

In the Step Name field, type Query Opportunities.

From the Action list, select Query Opportunities.

Check Persist Data as Output.

Enter Opps, then click Apply.

Click Add Step.

In the Step Name, enter Display Opportunities .

From the Action list, select Display Opportunities.

Check Provide Input and choose Opps as default.

Click Apply and then click Save.

Save the Application.

To create an action flow to save Opportunities

Click Action Flow and then click Create.

In the Action Flow Name field, enter Save Opportunities and click Apply. The left hand 

window is updated.

Click Add Step and in the Step Name field, enter Save .

From the Action list, select Save Opportunities.

Click Apply.

Click Save.

Save the Application.
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The  is to . Creating menus is a multi-step process.final step add the end-user menus

You first add a Group and highlight the group to add buttons underneath it.

For each group or button, you can change the names of each by overwriting the Default 

Group or Display Item in the right window.

When you add a button, Order is the order in which the buttons will appear on the end user 

menu.

Action Flow is for associating a menu button to the Action Flow that will be executed by the 

end user.

For icons, X-Author uses the standard Microsoft Office icon list which can be found here: 

. Use the icons described http://www.microsoft.com/en-us/download/details.aspx?id=21103

in the procedure below or use any other icon from the list. You must enter the icon name, 

including capitalization, exactly as it is documented in the procedure below.

The steps are described in detail in the following sections.

To create User Menus

Click User Menus.

Click Add Group.

In the Name field, type Opportunities and 1 in the Order field.

Click Add, and in the Name field, type Retrieve Opportunities.

In the Icon field, type GetExternalDataFromOtherSources and in the Order field enter 1.

Select Retrieve Opportunities from the Action Flow list.

Click on Opportunities to highlight the group and then click Add Button.

In the Name field, type Save Opportunities.

In the Icon field, type SaveObjectAs and in the Order field enter 2.

From the Action Flow list, select Save Opportunities.

Click Save.

Save the Application.

To make the end-user menus look presentable

http://www.microsoft.com/en-us/download/details.aspx?id=21103
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To make the end-user menus look presentable

Enlarge the title.

Highlight the row headings.

Identify to the end user the columns that are modifiable by highlighting them in a different 

color.

(Optional) You can delete the text in brackets. This does not remove the fields because 

those are in the map. This just makes the presentation more pleasing.

Make sure to place your cursor in the cell and use the  key. Delete Do not use 
Delete Row.

An App with the name  has been created. Now you can run it by clicking the Opportunities Forecast
Preview button in the ribbon menu.

The user menus you created now appear in the ribbon. Click the Retrieve Opportunities button and 

the list of opportunities is displayed. Make a few changes. Click Save Opportunities, and you will 

see a message that the records were saved. The changes are reflected in Salesforce.

Deleting an Application

You can not delete an App from within X-Author for Excel. You must log in to your Salesforce org 

using a web browser. Navigate to the All Tabs area of your Salesforce org by clicking on the plus 

sign on the main objects bar. You must have sufficient administrator credentials to perform this 

task.

To delete an Application

Log in to your Salesforce org using a standard web browser.

From the Force.com App Menu, select Apttus X-Author for Excel.

Click the Apps tab in the menu bar.
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Click Go located next to the X-Author for Excel picklist. This action will display all of the X-

Author Designer-created Apps.

Click Del located next to the App name to delete the App, and then click OK.

You have successfully deleted an App from the linked X-Author for Excel Salesforce org.
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Launching an X-Author for Excel App from 
Salesforce

From a button on any page in Salesforce, users can launch an App that opens in Excel and 

automatically retrieves the data from Salesforce. The flow is:

A button is clicked on any Salesforce page (that can accommodate a button).

A message box pops-up to warn the user that they are leaving Salesforce and whether they 

would like to continue.

A new instance of Excel is opened and connected to Salesforce without any additional login 

required by the user.

App id and (optionally) parent id are passed as parameters to the App.

The App opens in Excel and executes the Action Flow that has been flagged as auto-

execute.

To implement this feature, perform the following steps in order:

Adjust your App slightly so that it can be launched from Salesforce.

Add an Edit in Excel setting in Salesforce Setup to identify the App that should be launched 

from Salesforce.

Add a button in Salesforce.

You can launch a specific Action Flow of a specific app from Salesforce. To do so, you must 

mention the names of the app and action flow in the code of the button that you add. When an 

action flow is mentioned in the launch button code, it gets executed when launched from 

Salesforce. When an action flow is marked as Auto Execute (Launch from Excel) and you mention 

another action flow in the launch button code, the latter action flow gets executed when launched 

from Salesforce.
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Making an App Launch-Ready from Salesforce

There are only two differences in an app launched from Salesforce versus a regular App: 1, 

identifying which Action Flow should be executed at launch and 2, in the case of a parent-child 

App, providing an external id parameter.

Identify the Action Flow to be Executed on Launch

Click Action Flow from the X-Author for Excel ribbon.

Select an Action Flow for auto-execution by checking the box in the Auto-Execute (Launch 

from Salesforce) column. Only one Action Flow can be selected.

Adding an External ID to the Query

If this is an App that has no parent, such as a list of opportunities, make sure the query has the 

appropriate hard coded filters to retrieve the records you want.

If this is a parent/child App, then the query requires a filter to identify the parent field. For example, 

if the button is on the Opportunity related list for Accounts, then the Account Id is the parent id that 

is passed as a parameter.

To add an External ID to a query

Open the query that is retrieving the data.

Add a filter as follows - this example uses Account/Opportunity but you should select the 

parent id field in the object that looks up to the parent.

Click Save and Save the Application.
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Setting Up an Edit in Excel App in Salesforce

Switch to the X-Author for Excel application from the  App Menu or locate  Force.com Apps
using the + on the menu.

Click on Edit in Excel Setup.

Note

If the  button is not visible, you need to add it to your App page layout. Edit in Excel
Refer to  for instructions.Completing Setup for Designers

You will see a list of example Apps that come with the X-Author for Excel managed package.

Click + to add a new row.

In Name enter in a brief description, e.g. if launching Contacts from the Account page, you 

could use .Account - Contacts

From the Application drop-down, select the Application that will be launched.

Click Save.

http://Force.com
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Creating Buttons in Salesforce

There is no limit to the number of different Apps that can be launched from Salesforce. It could be 

a list of opportunities, or a list of opportunities or contacts for an account. You can place buttons 

anywhere Salesforce allows them to be located.

X-Author for Excel provides a few sample buttons. To see an example, search for buttons from 

Salesforce Setup, then navigate to the Opportunity buttons, and locate the Edit in Excel button.

To create a button on an object

You can create this button on standard as well as custom objects. This example shows how to 

create the Edit In Excel button on Opportunity related list on Account object.

Go to Setup > App Setup > Customize > Opportunities and select Buttons, Links and 

Actions.

Click New Button or Link.

Enter the Label. Name is auto-populated.

Enter the Description of the button to help users understand the button.

Select a Display Type for the button.

Display 
Type

Description

Detail 

Link 

Page

To display the custom button as a link

Detail 

Page 

Button

To display the custom button as a detail button. For example, to display the 

custom button with Edit, Delete, Cancel, and Clone buttons.

List 

Button

To display the custom button as a list button. For example, to display the 

custom button with Merge Contacts, New, Add to Categories and so on.
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Select a Behavior. Click View Behavior Options to view the options of behavior.

Select Custom Source.

If you are executing a specific Action Flow, then paste the following code in the Formula 

Editor:

/apex/Apttus_XApps__EditInExcelLaunch?parentRecordId={!Account.
Id}&"&appName=Account and 
Opportunities&actionflowName=retrieveOpp"

Important

Click Check Syntax to verify the syntax of formula you have written. You can 

choose to configure an App with a named action flow by passing actionflowName 

as a parameter and the name of the actionflow that you want to call as a value of 

the parameter. This feature is supported only on the X-Author for Excel 4.72 

Salesforce package.

If you are using an auto-execute Action Flow, enter the following code into the Formula 

Editor:

/apex/Apttus_XApps__EditInExcelLaunch?parentRecordId={!Account.
Id}&"&appName=3_8 AC_Opps ASC"

Select the Link Encoding. Default value is Unicode (UTF-8).

Click Save.

To add a button in a Salesforce page

You can add this button on standard as well as custom objects. For example, add the Edit In Excel
button on Opportunity related list on Account object.

Click the Accounts tab and select an account.
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Click Edit Layout.

Click Related Lists from the left pane of the Edit Layout box.

For an Opportunities-related list, click the  icon.

For Buttons, click the  icon.

Select Edit In Excel and click the  icon.

Click Ok.

If your Launch from Salesforce feature is not working as expected, you might not have set the 

correct user permissions to access.



X-Author for Excel February 2017 Designer and Runtime Guide

241 Copyright ©2011-2017 Apttus Corporation. All rights reserved.

1.  

2.  

3.  

X-Author for Excel Runtime Functions

The following runtime fuctions are available for X-Author for Excel apps.

Switch Connection

Opening Apps

Adding Rows or Records to a List

Adding Rows and Columns to a Matrix

Paste from Mapping

Deleting Records from Salesforce

Adding and Deleting Records

Chatter

Rich Text

Switch Connection

To connect to Salesforce from X-Author for Excel at Runtime

Click Connect and the Manage Connections window is displayed.

Under the Create a new connection section and in the Name field, enter the Salesforce.com 

user name.
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In the Login URL, add the URL. In many cases, the URL is login.salesforce.com for 

production orgs and test.salesforce.com for sandboxes. You can click the shortcut for either 

of these in Examples. For a custom URL, type the custom domain name.

Click Authorize.

Open an App.

The X-Author for Excel ribbon options are enabled.

Opening Apps

To be able to open an App, you must be connected to your Salesforce org.

To open an app

Click Apps and then click Open Application to view the available Apps to open.

Either scroll down to find an App or enter in the App name in Search by Application Name 

and click Search. Then either double-click on the App or click Select.
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The My Apps check box is an App designer option only for testing the Apps.

You can also select an App from the shortcut list.

After the App loads into Excel, the menu could include buttons specifically designed for that App, 

such as Retrieve Opportunities, as well as one or more of the X-Author for Excel standard buttons: 

Add Row, Paste, Delete Row(s) from Salesforce, and Chatter.

Adding Rows or Records to a List

New rows or records can be added to a list in Excel in one of two ways: either by using the Add 

Row button or by using one of the Paste functions from the Paste drop-down menu after you have 

copied spreadsheet data.

To add a row or record



X-Author for Excel February 2017 Designer and Runtime Guide

244 Copyright ©2011-2017 Apttus Corporation. All rights reserved.

1.  

2.  

1.  

2.  

3.  

To add a row or record

Click on the top part of Add Row to insert a single row or record.

Click on the bottom part of Add Row to insert more than one row.

There are three variations of the Paste function: Paste Values Only, Paste All, and Paste from 

Mapping.

If you are copying data from another worksheet (same or different workbook), Paste eliminates the 

need to use the Add Rows function. It automatically adds the exact number of rows and pastes the 

data into those rows simultaneously.

Use the standard Excel copy function or Ctrl+C to copy data from the source.

Click Paste > Paste Values Only to add rows and paste the data values.

Click Paste > Paste All to add rows and paste the data including formulas.

Adding Rows and Columns to a Matrix

Using the Add Matrix Row and Add Matrix Column buttons, you can add more data to your matrix. 

However, there are specific rules you must follow. The only time you can add a column or a row is 

when that row or column is defined with a Rendering Type of Dynamic and a Field Type of Field 

Value. If either the Rendering Type is set to Static, or the Field Type is set to Field Label, or both, 

the you  add the row or column to the matrix at runtime. Click the link after the following cannot
image to see all the possible combinations and which combinations allow you to add rows and 

columns to matrices.

See all possible matrix combinations and whether or not you can add rows and columns
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Matrix Configuration Add 
Row?

Add 
Column?

  Column: Static - Field Label 

Row: Static - Field Label #########Data########

NO NO

  Column: Static - Field Value 

Row: Static - Field Label #########Data########

NO

NO

  Column: Dynamic - Field Value

Row: Static - Field Label #########Data########

NO

YES

  Column: Static - Field Label 

Row: Static - Field Value #########Data########

NO

NO

  Column: Static - Field Value 

Row: Static - Field Value #########Data########

NO

NO

  Column: Dynamic - Field Value

Row: Static - Field Value #########Data########

NO

YES
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Matrix Configuration Add 
Row?

Add 
Column?

  Column: Static - Field Label

Row: Dynamic - Field Value #########Data########

YES

NO

  Column: Static - Field Value

Row: Dynamic - Field Value #########Data########

YES

 NO

  Column: Dynamic - Field 
Value 

Row: Dynamic - Field Value #########Data########

YES

 YES

Paste from Mapping

This function is used during data migration between Salesforce orgs and is specifically for copying 

data between source and target workbooks. See the Data Migration section for more details.

Open the Target App.

Click Paste > Paste from Mapping.

Select the source workbook file that contains the data to be copied and click Open.

The data will be transferred from the source file to the Target App.
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Deleting Records from Salesforce

To delete a row or multiple rows, select the row or consecutive rows and click Delete Row(s) from 

Salesforce. X-Author for Excel will then ask you to confirm deletion of these rows. After you click 

Yes, the records will be removed from Salesforce without any further save action or other user 

action. The rows will also be removed from the worksheet.

Adding and Deleting Records

Whenever a user right-clicks a cell, if the cell is a part of a Repeating range or is of type of 

SaveField only then the X-Author add row menu and remove row menu is displayed in context 

menu. The native Insert or Delete function disappears. The Add or Remove menu is enabled.

The menu functionally behaves the same as Current Add Row menu.
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Limitations of the Add Rows and Delete Rows functions

The user cannot access shortcut keys(Ctrl + and Ctrl -.) to insert or delete rows.

Chatter

This option opens a Salesforce Chatter feed in a separate window pane to the right of your Excel 

workbook. It provides both the Chatter feed and various options to share all or parts of your 

workbook directly into Chatter feeds. The X-Author for Chatter functionality requires both a 

Salesforce Chatter license that provides API access and an X-Author for Chatter license. For more 

detailed instructions, please refer to the X-Author for Chatter guide.

Rich Text

If a rich text field has been included in a list, it will display as either Click here to Add or Click here 

to Edit depending on whether that field already has data or not. When you click on a rich text field, 

it will launch a side window that can be used to add or edit rich text. When you have completed the 
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rich text modifications for a record, click Save to Excel. When you are done with all other changes 

to this or other records, then use the menu button provided in the template to save the data to 

Salesforce.
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2.  

1.  

App Sync for Picklists and Record Types

Picklists and Record Types can be used across multiple functional areas such as Save Maps, 

Query Filters, or Display Maps. When a picklist or a record type is used, the following 

enhancements are applicable:

If the values in an app are modified, added, or deleted in the Salesforce org,

Latest values are updated in runtime.

Rendered excel fields (independent and repeating) are updated.

The code block within X-Author for Excel which has a flag to determine whether there is a 

multi-select picklist in the app is executed only once per application instance. This improves 

the performance of the application.

User Scenarios

This section lists the various scenarios in which a picklist values may change in the app from 

SFDC and its runtime behavior.

Change values of a Dependent Picklist - Add a value in SFDC

For X-Author Excel App:

During runtime, the values in the picklist drop-down in the app should include the 

newly added picklist value.

Save operations with the new picklist are enabled via the app and in SFDC for the 

record that was edited in the app.

Change values of a Dependent Picklist - Remove a value from SFDC

For X-Author Excel App:

During runtime, the values in the picklist drop down in the app should not include the 

removed picklist value.
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Change values of a Dependent Picklist - Modify a picklist value in SFDC

For X-Author Excel App:

During runtime, the values in the picklist drop down in the app should include the 

modified picklist value and should not contain the value that was present prior to the 

modification.

Save operations with the modified picklist are enabled via the app and in SFDC for 

the record that was edited in the app.

Associate a Dependent Picklist to a parent picklist in SFDC

For X-Author Excel App:

During runtime, the values in the picklist drop down in dependent field should be as 

specified in SFDC in accordance to the parent picklist field. This should be done without any 

designer changes on the app.

Disassociate a Dependent Picklist from the parent picklist.

For X-Author Excel App:

During runtime, the values in the picklist drop down in the app should include all the present values 

and should not be restricted or associated to the previous parent picklist values.

(i.e. All the updated values should now be available in the app irrespective of the value present in 

the field shape.

You can also:

Create an app with a field of picklist data type(both single and multi-select picklist) and then 

go into Salesforce and change the data type to anything other than picklist and still be able 

to run the app without having it abort due to app sync issues (i.e. skip the app sync for that 

field).

Change field data type from Picklist to any other data type

For X-Author Excel App:

Runtime session is not aborted

An error balloon is displayed informing the user that the fields that did not sync with 

SFDC.
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3.  

1.  

Error details are stored in log files

For Presto App:

Runtime session is not be aborted.

Object had a specific record type when the app was built but the record type 
is deleted from SFDC.

For X-Author Excel App:

During design and runtime, all the fields that were not visible due to the record type should 

now be visible.

Object did not have a record type when the app was built - but record type was added later 

to SFDC.

For X-Author Excel App:

During design and runtime, all the fields should be shown in accordance with the record 

type added (For example, if a particular fields are hidden in the record type they should not 

be visible in X-Author for Excel).
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5.  

6.  

Configuring Presto Apps

The procedure below outlines the custom settings required to configure Presto Apps.

Go to Setup > Develop > Custom Setting. Look for DocGen System Properties. Click 

Manage.

Under this setting one entry must be created - If there are no records then click New. After 

clicking New, fill in the following details:

Name System Properties

Merge Call Timeout 
Millis

60,000

Merge Webservice 
Endpoint

https://mergews.apttus.net/cgi-bin/MergeServer/Bin/MMCGI.exe

(Production)

Go to Setup > Develop > Custom Setting. Look for X-Author For Excel System Properties. 

Click Manage.

Under this setting one entry needs to be created - If there are no records then click on New. 

Fill in the details as shown in the table below:

Name System Properties

Instance Url <Instance Url for your Salesforce Org>

For example: https://na16.salesforce.com

If you see more fields under System Properties, keep them unchanged.

Go to Setup > Security Controls > Remote Site Settings.

https://mergews.apttus.net/cgi-bin/MergeServer/Bin/MMCGI.exe
https://na16.salesforce.com
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6.  

1.  

Under this setting one entry needs to be created - if it doesn’t exist. Below are the details:

Remote Site Name: mergews

Remote Site URL: https://mergews.apttus.net

Disable Protocol Security Unchecked

Active Yes

Configuring a Presto App

Create a new detail page button on your target object and configure the button setting as 

shown in the illustration below:

Button or Link URL text needs to be set. Copy the code below into the text area.

/apex/Apttus_XApps__EditInExcelLaunch?selectedRecordId={!
Account.Id}

https://mergews.apttus.net
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&"&appName=Quote Calculator&mode=touchless&outputType=None"

You can also set the information on a button, link or VF page by using the following 

API in a class: Apttus_XApps.EditInExcelLaunchController editLaunch = new 

Apttus_XApps.EditInExcelLaunchController('TestPresto2', recId,'XLSX'); where the 

first parameter is the App name, second one is the record ID, and third one is the 

output format. This API returns a boolean value. On successful execution, the API 

returns true otherwise false.

To access the package for Presto as an API contact the Apttus Customer 

Excellence by raising a case with them or Apttus Release Management Team.

Replace the following section of the code:

selectedRecordId is the record id of the object that will trigger X-Author for Excel. For 

example if a button is created on the Account page, you will set the value as Account.Id.

appName is the name specified in Edit in Excel setup. This is NOT the actual name of the X-

Author for Excel app.

For example, as seen in the picture below, the appName will be Quote Calculator as 
 and NOT the actual name of X-Author for Excel app, which specified in Edit in Excel setup

in this case is SFDC - Quote Calculator.
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outputType can either be None, EXCEL or PDF. When it is set as Excel or PDF, Presto will 

attach the filled app template as an attachment to the selected record. The filename will be 

Template.xlsx or Template.pdf when output type is Excel or PDF respectively.

Copyright ©2017 Apttus. All Rights Reserved.
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